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Introduccio

ASP.NET és una plataforma de desenvolupament de Microsoft de les més este-
ses en la programacioé web. Combinat amb l'entorn de desenvolupament per
excel-lencia de Microsoft, el Visual Studio 2010, es poden crear sofisticades

aplicacions web de manera visual i rapida.

En aquest modul s’ofereix una introduccié a 'entorn de desenvolupament
(framework) .NET, una descripci6 a grans trets del llenguatge de programacié
C#1i, finalment, una introduccio a la plataforma de desenvolupament ASP.NET
4.0, incloent-hi els controls ASP.NET Ajax, que sén un dels aspectes diferenci-
adors respecte a altres plataformes de desenvolupament.
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Objectius

Els objectius d’aquest modul didactic sén els segiients:

1. Mostrar 1'Gs de la tecnologia Ajax en un dels entorns de desenvolupament
més utilitzats avui dia: .NET.

2. Coneixer que és ASP.NET i la seva implementacié Ajax.

3. Familiaritzar-se amb '’entorn de desenvolupament Visual Studio 2010.

4. Crear llocs web i dissenyar pagines ASP.NET interactives que responguin a
les diferents accions dels usuaris.

5. Comprendre el cicle de vida d'una pagina ASP.NET entre diferents tipus

de peticions.
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1. U'entorn de desenvolupament “.NET Framework”

.NET és un terme utilitzat per Microsoft per a donar nom a un conjunt de
tecnologies, —algunes de revolucionaries, altres no tant—, que estan dissenya-
des per a ajudar els desenvolupadors a crear diferents tipus d’aplicacions, des
d’aplicacions d’escriptori o serveis de Windows fins a aplicacions web.

El conjunt de tecnologies que formen I’entorn de desenvolupament' “.NET En anglés, framework.

Framework” soén les segiients:

e Els llenguatges de programaci6 .NET: entre els quals hi ha Visual Basic,
C#, F# 1 C++.

¢ El Common Language Runtime (CLR): és el motor que executa tots els
programes de .NET i que proveeix serveis automatics per a aquestes apli-

cacions, com la comprovaci6 de seguretat o la gestio de memoria.

e La biblioteca de classes de .NET: conté milers de classes, interficies, es-
tructures... amb una funcionalitat predefinida que es poden utilitzar en

les aplicacions .NET.

e ASPNET: és el motor que permet executar les aplicacions web creades
en .NET.

e Visual Studio: és1’eina de desenvolupament per excel-lencia de Microsotft.
Permet desenvolupar qualsevol tipus d’aplicacié .NET i depurar-la.

1.1. C# i Visual Basic

Durant aquest apartat, com es podra veure, utilitzarem el llenguatge C# per a
fer els exemples. Aquest llenguatge s’assembla bastant a Java i a C++. Al seu
torn, C# i Visual Basic sén bastant similars; de fet, gairebé qualsevol bloc de
codi pot ser traduit d'un llenguatge a un altre, pero la seva sintaxi és diferent.

Tant C# com a Visual Basic utilitzen la biblioteca de classes de .NAT i s6n
compatibles amb el CLR.
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1.2. El Common Language Runtime (CLR)

El Common Language Runtime (CLR?) és el motor que suporta tots els llen-
guatges .NET. En realitat, suporta el llenguatge intermedi entre el llenguatge

natiu i el llenguatge de programacié Microsoft Intermediate Language (MSIL?).
El CLR interpreta aquest codi intermedi i el transforma en codi maquina.

Per entendre-ho millor, el CLR seria el simil en Microsoft de la maquina virtual
en Java.

1.3. La biblioteca de classes de .NET

La biblioteca de classes de .NET és un repositori gegant de classes que propor-
cionen una funcionalitat predefinida, des de la lectura d'un arxiu XML fins
a l’enviament d’un correu electronic. Qualsevol dels llenguatges .NET pot uti-
litzar aquesta biblioteca de classes.

Certes parts de la biblioteca mai no s’utilitzen en programaci6 web i solament
s’utilitzen per a fer aplicacions d’escriptori, mentre que altres estan concebu-

des exclusivament per a aplicacions web.

Com hem pogut veure, la filosofia de Microsoft és proporcionar la infraestruc-
tura de les funcionalitats més comunes perque els desenvolupadors només ha-

gin de programar codi especific de 1’aplicacio.

@R és la sigla de Common Lan-
guage Runtime.

OMSIL és la sigla de Microsoft In-
termediate Language.
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2. El llenguatge de programacio C#

Abans de comencar a crear una aplicacié ASP.NET el programador ha de triar
el llenguatge de programacio, C# o Visual Basic. L'opcié normal si no s’ha
programat mai és Visual Basic, perqueé s’assembla més al llenguatge natural;
en canvi, si ja s’ha programat abans en C, C++ o Java ’elecci6 sol ser C#.

En aquest modul mostrarem les caracteristiques principals de C#, els tipus de
dades, les operacions, els condicionals o els bucles existents.

2.1. Caracteristiques i peculiaritats

Les principals caracteristiques que defineixen C# com un dels llenguatges més

potents i moderns d’avui dia son:
a) Es orientat a objectes. A excepci6é d’algunes dades simples com els enters,
flotants o strings, la resta de les entitats son classes predefinides en les biblio-

teques de classes de .NET.

b) Es un llenguatge compilat. Es necessita un compilador especific que tradu-

eixi el llenguatge C# a codi MSIL que, com sabem, és el que interpreta el CLR.

c) Disposa de la biblioteca de classes .NET. Des de C# tenim accés a tota la
biblioteca de classes de .NET, que implementa multitud de funcionalitats.

d) Disposa de garbage collector: La destruccio i alliberament de memoria es
gestiona de manera automatica i totalment transparent al desenvolupador.

D’altra banda, algunes de les peculiaritats que diferencien C# d’altres llenguat-
ges de programacio son:

a) Diferenciacio entre majascules i mintscules. En C# no és el mateix definir
una variable anomenada prova que una altra variable Prova. Alguns llenguatges

de programaci6, com per exemple Visual Basic, no fan aquesta distincio.

b) Comentaris. Els comentaris son textos descriptius que son ignorats pel
compilador. C# disposa de dos tipus de comentaris basics:

e FEl comentari d’una linia:

// Comentari d'una linia

e El comentari de multiples linies:
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/* Comentari de multiples

linies */

¢) Terminaci6 de senténcia. Tota senténcia en C# ha d’acabar amb el caracter

“;”. Es important recordar que una senténcia es pot compondre de més d’una

linia, com podem veure a continuacio:

// Senténcia en una linia

valor = valorl + valor2 + valor3;

// Senténcia en diverses linies

valor = valorl + valor2 +

valor3;

d) Blocs. Tot conjunt de senténcies ha de comencar amb el caracter “{” i aca-

bar amb el caracter “}”. Aquests conjunts poden ser funcions, classes, bucles...

//Conjunt de senteéncies

2.2. Variables i tipus de dades

Igual que en tots els llenguatges de programacio, en C# es poden mantenir da-

des en memoria utilitzant variables. Les variables poden emmagatzemar nom-

bres, text, dates, hores, i fins i tot poden desar adreces en altres objectes. Quan

es declara una variable se li assigna un nom i s’especifica el tipus de dades al

qual pertany.

//Declaracidé d'un enter anomenat codi

int codi;

//Declaracidé d'un string anomenat nom

string nom;

En la taula segiient podem veure els tipus de dades disponibles en C#:

Figura 1. Tipus de dades en C#

Nom del tipus

Descripcio

byte Enter de 0 a 255

short Enter de -32.768 a 32.767

int Enter de -2.147.483.648 a 2.147.483.647
long Enter de -9,2e18 a 9,2e18

float Nombre de coma flotant de -3,4e38 a 3,4e38
double Nombre de coma flotant de —1,8e308 a 1,8e308
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Nom del tipus Descripcio
decimal Nombre fraccionari de 128 bits
char Caracter Unicode
string Conjunt de caracters Unicode
bool Valor de true o false
DateTime Representacié de dates

2.2.1. Assignacions i inicialitzacions

Quan es declara una variable, s’hi poden assignar valors sempre que aquests

valors siguin del tipus correcte.

//Declaracié de variables
int codi;

string nom;

//Assignacié de valors
codi = 10;

nom = "UOC"

També es pot assignar un valor en el mateix moment en que es declara la

variable.

int codi = 10;

string nom = "UOC"
2.2.2. Arrays

Els arrays permeten al desenvolupador emmagatzemar una serie de valors del
mateix tipus. Es pot accedir a cada valor mitjancant la posicié6 que ocupa en
I'array, tenint en compte que el primer valor d'un array té index O.

//Creacié6 d'un array amb quatre strings

string[] stringArray = new stringl[4];

//Creacidé i inicialitzacidé d'un array amb quatre strings
stringl[]

StringArray = ("1","2","3","4"};
Per a accedir a un element, se n’ha d’especificar 'index entre claudators [].

int[] intArray = {1,2,3,4};

int element = intArray([2]; //element s'inicialitza amb un 3
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2.2.3. Arraylist

Els arrays en C# no poden ser redimensionats, és a dir, una vegada creats no
es poden canviar de mida. Si es necessita un array dinamic, es pot utilitzar
una classe de la biblioteca de classes de .NET anomenada ArrayList, que a més
accepta que els elements dels arrays siguin de qualsevol tipus.

Utilitzacié de la classe ArrayList
A continuacié veiem un exemple d’utilitzaci6 de la classe ArrayList:

//Creacidé d'un objecte ArrayList

ArrayList llistaDinamica = new ArrayList();
//Addicié de diferents strings a la llista
llistaDinamica.Add ("primer");
llistaDinamica.Add ("segon") ;
llistaDinamica.Add ("tercer") ;

2.2.4. Enumeracions

Una enumeracio és un grup de constants relacionades, a cadascuna de les quals
es déna un nom descriptiu. Cada valor d’'una enumeracié correspon a un nom-

bre enter prefixat.

//Definicié d'una enumeracid anomenada TipusUsuari
enum TipusUsuari
{

Admin,

Convidat,

Erroni

Ara ja es pot utilitzar TipusUsuari com un tipus de dades especial amb només
tres valors.

//Creacibé d'un nou valor de tipus Admin

TipusUsuari usuari = TipusUsuari.Admin;

2.2.5. Operacions amb variables

En C# el desenvolupador pot utilitzar tots els tipus estandard d’operacions.
Quan es treballa amb tipus numerics es poden utilitzar els simbols matematics
que podem veure en la taula segiient:

Figura 2. Operacions en C#

Operador Descripcio Exemple
+ Suma 1 +1=2
- Resta 5 2 =23

* Multiplicaci6 2 *5 =10
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Operador Descripcio Exemple
/ Divisio 5.0 / 2 =2.5
% Residu de la divisié sencera 7%3=1

Per a controlar l'ordre en qué s’executen, les expressions poden agrupar-se

entre parentesis.

int nombre;

nombre = 4 + 2 * 3;
//nombre sera 10
nombre = (4 + 2) * 3

//nombre sera 18

La divisi6 en C# pot ser una mica confusa. Si es divideix un nombre enter per
un altre enter, C# fa una divisio entera, és a dir, es descarta automaticament la
part fraccionaria del resultat. La solucié a aquest problema és definir un dels
nombres, o tots dos, com a fraccionaris; per exemple, 5 passaria a ser 5. 0.

D’aquesta manera obtindrem un resultat correcte.

En C# l'operacio addici6 + es pot utilitzar també per a concatenar strings.

//Concatenacié de tres strings

nomComplet = nom + " " + cognoms;

En C# quan l'operacio i 'assignaci6 es fan sobre la mateixa variable es poden

utilitzar els operadors de la manera segiient:

//Afegir 10 a valor. Es el mateix que valor = valor + 10
valor += 10
//Multiplicar valor per 3. Es el mateix que valor = valor * 3

valor *= 3

2.2.6. Conversions de tipus

Convertir informacié d'un tipus de dada a un altre és una cosa bastant comu-
na en el mén de la programacio. Les conversions de dades poden ser de dos
tipus: implicites o explicites; per exemple, la conversi6é d'un tipus int a un de
long és implicita, perque no implica perdua d’informacid; no obstant aixo, la
conversi6é d'un tipus long a un d’int és explicita, a causa que hi pot haver

pérdua d’'informacié.
Per a les conversions implicites no es necessita cap codi especial:
int valorPetit;

long valorGran;

//La conversid sempre es pot fer perque un long pot contenir un int
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valorGran = valorPetit;

En canvi, en les conversions explicites, és necessari indicar el tipus entre pa-

réntesis a I'esquerra de la variable.

int valorGran = 1000;

short valorPetit;

//S1i el valorGran supera la capacitat d'un short hi haura peérdua d'informacid.

valorPetit = (short)valorGran;

2.2.7. El tipus String

La classe string de la biblioteca de classes de .NET ens permet manipular de

multiples maneres una cadena de text.

Exemple

string mistring =
mistring = mistring.Trim();

mistring = mistring.Substring(0,4);
mistring = mistring.ToUpper/();
mistring = mistring.Replace ("O","A");

int longitude = mistring.Length;

"Aixd és un string d'exemple ";

//"Aixd és un string d'exemple";
//"Aixo";

//"AIXO";

//"AQUESTA";

/] = 4;

En els exemples anteriors cada métode de la classe String genera un nou string que és
assignat a la variable mistring. Totes aquestes senténcies es poden fer en una sola linia:

mistring =

mistring.Trim() .Substring(0,4) .Replace("0O","A");

En la taula seglient veiem algun dels metodes i propietats més importants de

la classe String:

Figura 3. Funcions i propietats de la classe String

Membre

Descripcio

Lenght

Retorna el nombre de caracters de I'string.

ToUpper () i ToLower ()

Retorna un string amb tots els caracters de I'string original en majiscula o minds-
cula.

Trim() Retorna un string sense els espais de |'string original.

Insert () Insereix un altre string en |'string original en la posicié indicada.

Remove () Elimina un nombre determinat de caracters des d’una posicié determinada.
Replace () Reemplaca un substring de |'string original amb un altre string.

Substring () Retorna una porcié de I’string d’una longitud determinada.

StartsWith () i EndsWith ()

Determina si un string comenca o acaba en un substring determinat.

Split ()

Retorna un array amb tots els substrings resultants de seccionar I'string per a un
caracter determinat.

Join ()

Fusiona un array de strings en un string Unic.
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2.2.8. Els tipus DateTime i TimeSpan

Els tipus de dades DateTime i TimeSpan disposen de metodes i propietats per
a manipular dates i temps, respectivament.

Exemples

Podem veure a continuacié un exemple de manipulacié de dates amb DateTime:
DateTime lamevaData = DateTime.Now;
miFecha lamevaData.AddDays (100) ;

string dateString lamevaData.Year.ToString();

En I’exemple segiient veiem com podem buscar la diferéncia en minuts entre dues dates:

DateTime lamevaDatal
DateTime lamevaData2
TimeSpan diferencia;

DateTime.Now;
DateTime.Now.AddHours (3000) ;

diferencia = lamevaData?2.Substract (lamevaDatal) ;
double nombreMinuts;
nombreMinuts = diferencia.TotalMinutes;

Les classes DateTime i TimeSpan també suporten els operadors aritmetics + i
-, fins i tot entre un objecte DateTime i un altre de TimeSpan.

Exemple

DateTime lamevaDatal = DateTime.Now;

TimeSpan interval = TimeSpan.FromHours (3000) ;
DateTime lamevaData2 = lamevaDatal + interval;

A continuacié podem veure dues taules amb alguns meétodes i propietats de
les classes DateTime i TimeSpan:

Figura 4. Funcions i propietats de la classe DateTime

Membre Descripcio

Now Retorna la data i hora actuals.

Today Retorna la data actual.

Year, Date, Month, Hour, Minute, Second iMillisecond Retorna una part d’un DateTime.

DayOfWeek Retorna el dia de la setmana d’un DateTime.

Add () i Subtract () Afegeix o resta un TimeSpan d'un DateTime.

AddYears (), AddMonths (), AddDays (), AddHours (), AddMi-
nutes (), AddSeconds (), AddMilliseconds ()

Afegeix una porcié de temps a un DateTime.

DaysInMonth () Retorna el nimero de dia d’'un mes determinat.

Figura 5. Funcions i propietats de la classe TimeSpan

Membre Descripcio

Days, Hours, Minutes, Seconds, Milliseconds

Retorna una part d’un TimeSpan.

TotalDays, TotalHours, TotalMinutes, TotalSeconds,
TotalMilliseconds

Retorna el total de dies, hores... que té un TimeSpan.
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Membre Descripcio
Add () i Subtract () Afegeix o resta un TimeSpan a un altre TimeSpan.
FromDays (), FromHours (), FromMinutes (), FromSe- Construeix un TimeSpan a partir de dies, hores...
conds (), FromMilliseconds ()

2.3. Condicionals logics

Moltes vegades es necessita una condici6 logica per a decidir quina acci6 cal
prendre sobre la base d’'una informaci6 determinada. Una condici6 logica pot
ser avaluada com a veritable o falsa i en funcié d’aix0 executar un bloc de codi
o un altre. Per a crear una condicié podem utilitzar qualsevol combinaci6 de
variables o literals amb els operadors logics que veiem en la taula segiient:

Figura 6. Condicionals en C#

Operador Descripcio

== Igual que

1= Diferent que

< Més petit que

> Més gran que

<= Més petit o igual que
>= Meés gran o igual que
&& AND logic

Il OR logic

La senténcia if és la peca clau de la logica condicional en la programacio. A
continuacié veiem un exemple en qué s’avalua una condici6 i s’executa un

bloc de codi o un altre:

if (nombre > 10)

{
//Bloc A

else

//Bloc B

C# també posa a la nostra disposicio la senténcia switch, que ens serveix per
a avaluar una variable per a diversos valors possibles. L'tnica limitaci6 de la
senteéncia switch és que la variable solament pot ser dels tipus int, bool,

char, string o el valor d’'una enumeracio.
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switch (nombre)
{
case 1:
//Bloc A
break;
case 1:
//Bloc B
break;
default:
//Bloc C

break;

Veiem que en cada bloc de codi hem d’indicar la paraula break; si no ho

féssim, es continuaria executant el codi de manera seqiiencial.

2.4. Bucles

En C#, igual que en la majoria de llenguatges, hi ha tres tipus de bucles per a

executar blocs de codi de manera iterativa: for, foreach i while;

El bucle for permet al programador poder repetir un bloc de codi un nombre
predeterminat de vegades. Per a crear un for és necessari especificar un valor

inicial, un valor final i I'increment de cada iteracio.

for (int i = 0; 1 < 10; i++)
{

//Bloc de codi

Elbucle foreach ens permet recOrrer els elements d'un conjunt de dades. Amb
un foreach no és necessari crear una variable per al comptador, i a més és
especialment til per a recOrrer llistes, arrays o col-leccions de dades en general.

string[] stringArray = {"un","dos","tres"};
foreach (string element in stringArray)
{

System.Diagnostigs.Debug.Write (element + " ");

Finalment, C# disposa del bucle while, que serveix per a comprovar una con-
dici6 especifica abans o després de cada iteracié d'un bloc de codi. Quan aques-
ta condicio6 és falsa, se surt del bucle; per contra, mentre sigui veritable es van

fent iteracions en el bloc de codi.

int i = 0;

while (i < 10)
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i 4= 1g

Una altra manera d’implementar el bucle while és posant la condici6 al final
del bloc de codij, i d’aquesta manera ens assegurem que el codi s’executa al-
menys una vegada.

int i = 0;

do

i 4= 1;

} while (1 < 10);

2.5. Meétodes

Els metodes en C# son el bloc de codi més basic que podem utilitzar per a
organitzar el nostre codi. Quan es declara un metode la primera part de la
declaraci6 indica el tipus de dades del valor de tornada i la segona el nom del

metode.

//Métode que no retorna cap valor
void MetodeQueNoTornaValor ()

{
//Codi

//Metode que retorna un enter
int MetodeQueRetornaUnlInt ()

{

return 10;

Els meétodes poden acceptar parametres. Els parametres es declaren de manera

molt similar a la declaracié de variables.

int sumaNombres (int nombrel, int nombre2)
{
return nombrel + nombre2;
}
//Crida al métode

int resultat = sumaNombres (10,10) ;

Cal destacar que en la declaraci6 dels parametres els podem donar un valor
per defecte.

private string NomUsuari (int ID, bool esAdmin = false)
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//Codi

Una caracteristica propia de C# relacionada amb els metodes és la sobrecarrega,
és a dir, podem crear més d'un metode amb el mateix nom perd amb diferents

parametres.

public decimal GetPreuProducte (int ID)
{

//Codi
}

public decimal GetPreuProducte (string nom)
{
//Codi

2.6. Classes i objectes

C#, com hem dit, és un llenguatge de programaci6 orientat a objectes. Una
classe és la definici6 del codi d’un objecte i la creacié d’una classe en C# es

fa de la manera segiient:

public class LaMevaClasse

{
//Codi de la classe

En una classe podem definir variables que siguin variables membre o propie-
tats de la classe. Aquestes variables poden tenir diferents nivells d’accés, que

s’especifiquen en la declaraci6 de la variable.

public class Producte

{
private string nom ;

private decimal preu;

En la taula segiient podem veure els diferents nivells d’accés disponibles en C#:

Figura 7. Nivells d’accés en C#

Nivell d’accés Accessibilitat
public Accessible des de qualsevol classe
private Només accesible des de membres de la mateixa classe

internal Accesible des de qualsevol classe de |'assemblat actual
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Nivell d’accés Accessibilitat

protected Accessible des de membres de la mateixa classe o des de
classes que hereten d’aquesta

Per a una classe també podem definir una serie de metodes, que anomenarem
métodes membre, i igual que una variable membre, ha de tenir el nivell d’accés
definit a la declaracio.

public class Producte
{
private string nom ;

private decimal preu;

public decimal GetPreu()
{

return this.preu;

Un metode especial que totes les classes han de tenir és el constructor de classe,
que és 'encarregat d’inicialitzar els parametres de la classe. Hi pot haver un
o més constructors, el nom dels quals sera el mateix de la classe a la qual

pertanyen, pero que es diferenciin en el conjunt dels parametres que es passa
a cadascun.

public class Producte
{
private string nom ;

private decimal preu;

public void Producte (int preulnici)
{

this.preu = preulnici;
public decimal GetPreu()

return this.preu;

Una vegada hem construit una classe com l'anterior en podem crear tantes

instancies com vulguem; cadascuna sera el que es denomina objecte.

Product producteVenda

new Product (50) ;

int preu

producteVenda.GetPreu() ;
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3. Introduccié a les eines de desenvolupament

Les aplicacions ASP.NET es poden crear amb un simple editor de textos, intro-
duint tot el codi —tant el disseny de la interficie (XHTML/CSS/JavaScript) com
la logica (codi C#)- en moduls . aspx, que serien compilats dinamicament pel
motor d’ASP.NET en el moment de rebre les sol-licituds.

Aquesta, no obstant aix0, és una soluci6 viable inicament per a projectes molt
petits, ja que és dificil mantenir un disseny d’interficies a partir de I’escriptura
manual dels atributs de tots els elements i d"'una barreja de codis en diferents

llenguatges en un mateix arxiu.

Depenent de quins siguin els nostres objectius i necessitats, tenim a la nostra
disposicio diferents eines atils per al desenvolupament d’aplicacions basades
en ASP.NET. El punt de partida seria Visual Web Developer Express. Es tracta
d'una eina gratuita, descarregable directament des del lloc web de Microsoft
i amb els elements necessaris per a construir aplicacions basiques i de nivell
mitja, amb limitacions sobretot a I’hora de treballar amb servidors de bases
de dades.

Més sofisticats son els entorns de treball que ofereixen les diferents versions
del Visual Studio 2010, que, a més d’aplicacions ASP.NET, tenen capacitat per
a desenvolupar molts tipus de projectes: aplicacions per a Windows, per a dis-
positius mobils, per a I’Office, etc.

3.1. Visual Studio

Des de fa anys, 1’eina de desenvolupament per excel-léncia per a plataformes
Windows es denomina Microsoft Visual Studio, un producte que reuneix com-
piladors per a diferents llenguatges, editors de codi amb caracteristiques avan-
cades d’ajuda a la codificaci6, dissenyadors d’interficies d'usuari, depuraci6
integrada, gestio de projectes complexos, edici6 de bases de dades tant locals

com remotes, etc.

Laltima versié del Visual Studio és la 2010 (figura 8), i va unida a la versio
4.0 de la plataforma .NET. A 1'hora d’iniciar un nou projecte, no obstant ai-
X0, €és possible triar la versio de la plataforma .NET sobre la qual s’executara:
2.0, 3.0, 3.5 0 4.0. Aix0 permet usar una Unica eina per al desenvolupament
d’aplicacions sobre diferents versions de la plataforma.
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Hi ha disponibles multiples edicions del Visual Studio dirigides tant a usuaris
individuals (Standard i Professional) com a grups de treballs (Team System).
Quant al desenvolupament d’aplicacions web basades en ASP.NET, les seves
capacitats son basicament les mateixes.

Figura 8. Visual Studio 2010

r .
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File Edit View Project Build Debug Team Data Tools Architecture Test ReSharper Analyze Window Help
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100% ~ ¢ m » e
in B
@ Design | O Split [@ Source
g pit (@ Source | Background
3 ] BgColor e
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A diferéncia del Visual Studio, el Visual Web Developer €s una eina especifica
per al desenvolupament d’aplicacions web amb ASP.NET que no té opcions
per a la construccié d’altres tipus de projectes. Per tant, si necessitem dissenyar
solucions complexes en qué 1’aplicacié web sigui solament una de les parts, el
Visual Web Developer ens resultara insuficient i haurem de recérrer a alguna
de les edicions del Visual Studio. Pel que fa al nostre curs, tindrem més que

suficient amb aquesta eina.

El Visual Web Developer permet usar com a llenguatge d’implementacio tant
el Visual Basic com el C#, pero no permet seleccionar la versi6 de la platafor-
ma .NET sobre la qual s’executara el projecte, i s'assumeix sempre que sera la
4.0.

Una altra diferencia respecte al Visual Studio és que el Visual Web Developer
solament permet treballar amb bases de dades locals, no remotes. Tampoc no
hi ha la possibilitat d’efectuar depuracié remota, amb l'aplicacié executant-se
en un equip que no sigui el de desenvolupament.

Pel que fa a la resta, el Visual Web Developer incorpora el mateix dissenyador
de pagines ASP.NET que el Visual Studio, el mateix editor de codi, els matei-
xos components i també els mateixos serveis fonamentals: els de la platafor-
ma .NET 4.0.
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El gestor de projectes és practicament idéntic al del Visual Studio, igual que
I’Explorador de bases de dades, I'Explorador d’objectes i moltes altres utilitats

incloses en ’entorn.

Figura 9. Formulari de creacié amb les diferents plantilles disponibles

Nuevo sitio web

plork a2 ecionte Ordenar por: | Predeterminado v | o]

Plantillas instaladas
B siio web asp.neT visual C# Tipo: Visual C#

Visual Basic i=ch ’ Un sitio web ASP.NET.
%ﬁ Sitio web ASP.NET (Razor) visual Ci#
@g Sitio web vacio de ASP.NET visual Ci#
L‘?/’ Sitio web de entidades de datos dindmicos de ASP.NET Visual C#
L(?/’ Sitio web de Ling to SQL de datos dinémicos de ASP.NET visual C#
oh g Servido Wer visual C#
Ubicacién web: | sistema de archivos | | C:\Documents and Settings\Otrosiis Studio v| [ exemier... |

3.1.1. Instal-lacié del Visual Web Developer

Perque puguem descobrir les capacitats del Visual Web Developer primer és
necessari instal-lar ’eina. Per a aix0 accedirem a la pagina de Microsoft Visual

Web Developer 2010 Express.

Una vegada a la pagina, farem clic sobre el bot6 Install now. Aixo llancara el
Web Platform Installer, que ens baixara i instal-lara el producte automatica-

ment.

Figura 10. Web Platform Installer

Lanzar aplicacién @

Eto endace debe ser ablerto con uny aplcacin.
Ervier &:

Elegr una apkcackin

() Recordar mi eleccién para ks enlaces wpl,

| acoptar | | Concelor |



http://www.microsoft.com/visualstudio/en-us/products/2010-editions/visual-web-developer-express
http://www.microsoft.com/visualstudio/en-us/products/2010-editions/visual-web-developer-express
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Una vegada el Web Platform Installer inicii l'instal-lador del Visual Web Deve-
loper, premem en el bot6 Instalar.

Figura 11. Instal-lacié del Visual Web Developer Express

¢ Instalader de plataforma wed 3.0

© Visual Web Developer Express 2010 SP1

Lovhang for e Latest everythung’ Losk ne further. This will get you Visusl Web Developer Lpress
2010 Servace Pack | and e RTME relenses of A NET AVC § 35735 Eapeess, 500 Serves Compact
48 wth tosker and Web Deploy 28 33 the vahue meal of Macrosolt products. Tel your frnends’

e Phote Thes bundle onchades the Viussl Web Developes [press 2010 D1 meb wntalies whech wil
sual Studio Bymarrec aby detemvarne the appeogmnate sere e pach omgranents 1o downdssd and wotall Thes n
Sy aBy n B sange of 200-500 LB andd el tak o 40 rurnstes 00 wnital dopendeng on your
s D selrgpm e
Lo Merarefy
Tamnats de s descagn 400 0
Versse 1008021501

Fecha de commoniaacren porves 39 de marse de NIL

1 Usmentes pace mataler Opcenes ( Sretatae ][ ke )

Acceptem les condicions d'ts i el programa d’instal-laci6 baixara el Visual Web
Developer i I'instal-lara de manera autonoma.

Figura 12. Condicions d’ls

Instalacién de plataforma web m
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proporcionan los terceros que se enumeran aqui. Microsoft no le concede ningun derecho para el software de terceros.
Usted debe y es5 responsable de buscar, leer y aceptar por separado 1os terminos de icencia de e5tos terceros

2% Visual Web Developer Express 2010 SP1 [Espadiol] A
Visual Web Developer 2010 Express [Espafiol] (dependencia) 32575 M8
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Veetiomsinmes do Koswoie
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enumerados antenormente. St no esta de acuerdo con todos los terminos de hicencia, haga chic en "No acepto”

0 Ayude 3 mejorar los productos de Microsoft enviando a Microsoft informacion basica sobre la configuracion y uso
para los productos de Microsoft antenores

Declaraciones de privacidad

No acepto l I Acepto

3.1.2. Galeria de plantilles

En triar I'opci6 File > New > Web Site, o fer clic en el bot6 equivalent en la barra
d’eines, veiem la galeria de plantilles instal-lades. Cada plantilla permet crear
un tipus de projecte diferent o que contingui una serie d’elements diferents
de partida.

En la galeria de plantilles (figura 9) sempre triarem 1'opci6 Sitio web ASP.NET
i, abans de fer clic sobre el bot6 Aceptar, establirem els parametres seglients:
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e La ubicaci6é on s’allotjara el projecte, que es pot triar entre aquestes tres
possibilitats: Sistema de archivos, HI'TP i FTP. En el nostre cas sempre tria-
rem Sistema de archivos i indicarem la ruta on s’allotjara el projecte.

e [FElllenguatge de programacio6 que s’utilitzara per a codificar la logica: Visual
Basic o C#. En el nostre cas, C#.

Una vegada establerta la configuracié de 1'aplicaci6, un clic en el bot6 Aceptar
generara el projecte amb els moduls inicials.

3.1.3. Explorador de solucions

Una vegada generat el projecte, els elements que el componen apareixeran
en el Solution Explorer (figura 13), una eina fonamental per a 'administracio
dels projectes.

Figura 13. L'Explorador de solucions i el mend contextual associat al projecte

Solution Explorer

al »E@

A NuevaAplicacion
24 My Project | [53 Build
 Acceunt Rebuild
3 App_Data
(23 Scripts
(3 Styles
2] Aboutaspx | % Publish...
| Defaultaspx | % Package/Publish Settings

&) Global.asax &) View in Browser Ctrl+ Shift+ W
7] site.Master

1 Web.config

Clean

2 Build Deployment Package

Convert to Web Application

Add * | 2] Newltem.. Ctrl+Shift+A
Add Reference... 2 Bdsting Item... Shift+Alt+A
Add Service Reference... [Z4 New Folder

Add Deployable Dependencies... Add ASP.NET Folder »
Use IIS Express... #] Module...

Debug » | ¥g  Class...
Cut Ctrl+X ’
Paste tri+V

&3 Solution Explorer Rename
a2 Properties Alt+Enter

N Anlirari Prower¥

En principi, en aquesta finestra trobarem tres elements: la carpeta App Data,
la pagina Default.aspxiel modul de configuracié web.config. La pagina té
associat un arxiu de codi anomenat Default.aspx.cs. En seleccionar qual-
sevol dels elements en la finestra Properties, apareixeran totes les seves propi-
etats. Amb el bot6 secundari del ratoli podrem accedir al ment contextual,
especific segons el tipus d’element que hi hagi sota el punter del ratoli. Sim-
plement amb un doble clic en un element dels mostrats en I’Explorador de
solucions 1'obrirem en el seu editor/dissenyador predeterminat. Recorrent al
menu contextual es pot optar per obrir el modul en un altre programa, elimi-

nar-lo del projecte, copiar-lo o dur a terme tasques especifiques.
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El menu contextual associat al projecte permet generar-lo i executar-lo, i també
agregar referéncies i altres elements. L'opcié Add > New element déna pas a un
quadre de dialeg similar al de la figura 14, en el qual es troben tots els tipus
d’elements que és possible utilitzar en una aplicacié6 ASP.NET.

Figura 14. Quadre de dialeg per a agregar nous elements a un projecte

LMd New Item - Nﬁrr-' - (-2 e
Installed Templates Sort by: i [ search Installed Templates »|
4 Visual Basic - .

Code Web Form Visual Basic Type: Visual Basic
Aform for Web Applications
Data B
General =-=| Web Form using Master Page Visual Basic
Silverlight 5= Web User Control Visual Basic
Online Templates Vi
ﬂ Class Visual Basic |z
Master Page Visual Basic
"] Nested Master Page Visual Basic
ﬂ HTML Page Visual Basic
t}j Style Sheet Visual Basic
@ JScript File Visual Basic
VE'SE AJAX-enabled WCF Service Visual Basic
ﬁ ASP.NET Handler Visual Basic
%] ASP.NET Module Visual Basic
A ASP.NET Server Control Visual Basic
Name: WebForml.aspx
Add Cancel

3.1.4. El dissenyador de pagines

Quan creem un nou projecte, o fem doble clic sobre un modul .aspx en el
Solution Explorer, veurem com s’obre el dissenyador de pagines ASP.NET. Aquest
es compon d'un dissenyador visual, similar a qualsevol dissenyador web, i
d'un editor de codi XHTML/CSS. En la part inferior les opcions Disefio, Dividir
i Cddigo permeten alternar entre tres vistes diferents: inicament els elements
de disseny, el dissenyador i I'editor, o inicament 1’editor de codi. En la figura
15 es pot veure la segona de les opcions, amb la part central dividida en dues
seccions. La part superior és l’editor i la inferior el dissenyador.

Mentre es treballa en el dissenyador (la part inferior en la figura 15), és possible
utilitzar elements habituals en el disseny de pagines web. La barra de botons
que hi ha en la part superior facilita la selecci6 de tipus i mides de lletra, colors
de tinta i fons, alineacio, fins i tot de les llistes numerades i sense numerar, etc.
També es pot recorrer a finestres auxiliars, com Aplicar estils, Propietats CSS i
Administrar estils, que faciliten tota la gestio dels atributs que estableixen 1’estil
dels elements continguts a la pagina. Els ments Format i Taula, actius solament
quan esta actiu el dissenyador, ofereixen opcions addicionals d’aplicacié de
format i inserci6 de taules HTML.
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Figura 15. Dissenyador de pagines i editor de codi combinats en una mateixa vista
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En qualsevol moment és possible canviar del dissenyador a l'editor de codi ~ ®En angles, tag.
i treballar sobre aquest. Els canvis duts a terme en el dissenyador es reflectei-

xen immediatament en el codi i viceversa. En escriure codi, quan introduim

el caracter < per a iniciar una etiqueta®, I'editor ens oferira ajuda immediata

per mitja de llistes d’elements XHTML, atributs CSS, valors que permet cada

atribut, etc. En la figura 16, per exemple, es pot veure la llista de valors que

permet l'atribut style d'una etiqueta h2.

Figura 16. No és necessari coneixer de memoria els elements i atributs de XHTML/CSS, I’editor ens els recorda
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Encara que usant l’editor XHTML/CSS és possible introduir qualsevol element
en una pagina, per regla general resultara molt més comode fer-ho recorrent
a la finestra Toolbox (vegeu la figura 17). Normalment, la trobarem oculta en

el marge esquerre de 'entorn.

En el Toolbox, els components apareixen agrupats en diverses categories: Vali-
dation, Ajax Extensions, HTML, etc. Els del grup HTML no sén més que elements
estandard d’XHTML, de vegades amb algunes propietats preestablertes. La res-
ta son components d’ASP.NET, és a dir, porcions de codi que s’executaran en el
servidor, faran un cert treball i generaran com a resultat etiquetes XHTML/CSS.

La inclusi6 de qualsevol tipus de component en la pagina és una ope-
raci6 realment senzilla: només cal agafar-lo de la finestra Toolbox i ar-
rossegar-lo fins a la superficie del dissenyador. En aquest moment en
l'editor de codi s’introduira l'etiqueta corresponent, generalment del ti-
pus <asp:NomComponent atribut="valor”...>, i en el dissenyador

s’apreciara 'aspecte del control.

Cada vegada que s’arrossega un component des del Toolbox fins a la superficie
de disseny, el que s’obté és una copia, un objecte (una instancia d'una classe),
amb uns atributs generals. Aquests es poden personalitzar modificant les pro-
pietats que exposen, utilitzant per a aix0 la finestra Properties (figura 18).

La modificaci6 de certes propietats, com les que afecten I'estil del component,
pot tenir un reflex immediat en 'aspecte de 1’'objecte en el dissenyador. En
altres casos, no obstant aix0, les propietats tenen efecte inicament durant
I’'execuci6 de l'aplicacid, com per exemple, la propietat AutopostBack, amb
la qual es regeix el comportament del component una vegada que esta en el
navegador del client, i determina si el canvi d'una propietat del component

mateix provoca o no una comunicacié amb el servidor.
3.1.5. L’editor de codi C#

A mesura que es va dissenyant la interficie de ’aplicacio, col-locant compo-
nents en el dissenyador i personalitzant-ne les propietats, 1’habitual és que
també es vagi codificant la logica, establint el codi que s’ha d’executar quan
s’envii un formulari de dades, es canvii la seleccié d’una llista, etc. La intro-
ducci6 del codi en el servidor, que en gran part estara associat a esdeveniments
generats per la pagina o els components continguts en aquesta, es du a terme

mitjancant un editor especifico per a C#.

Es pot obrir I’editor de codi de diferents maneres:

Toolbox O X

=%  wrvpouwiie a0

FileUpload
HiddenField

L,ﬁ

Hyperlink
Image
ImageButton
ImageMap
Label
LinkButton
ListBox
Literal

B > B @ B >

[
<

=

Localize
MultiView
Panel
PlaceHolder
RadioButton
RadioButtonList
Substitution
Table

TextBox

&

\
>

m

MoK DOO

® 1
14 A

View

% Wizard

O

E  Xml
Data
Validation -

Figura 17. Quadre d’eines

Properties v AaXx
Calendarl <CALENDAR> -

o2 |2

4 -
AccessKey
Caption -
CaptionAlign NotSet |
Tablndex 0

UseAccessibleHead True

BackColor

BorderColor

BorderStyle NotSet
BorderWidth

CssClass
DayHeaderStyle-Ba
DayHeaderStyle-Bo
DayHeaderStyle-Bo NotSet
DayHeaderStyle-Bo
DayHeaderStyle-Cs
DayHeaderStyle-Fo
DayNameFormat ~ Short
DayStyle-BackColoi
DayStyle-BorderCol
DayStyle-BorderSty NotSet
DayStyle-BorderWic
DayStyle-CssClass
DayStyle-ForeColor 8

(ID)

Figura 18. Llista de propietats
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¢ Fent doble clic sobre un component per a associar codi al seu esdeveni-
ment per defecte.

e Usant el bot6 View Code del Solution Explorer tenint triada qualsevol pagina
ASP.NET.

e Fent clic en el botd Events de la finestra Properties des del dissenyador, per
a accedir a la llista d’esdeveniments del component que es tingui selecci-
onat, i després triant I'esdeveniment al qual es vol associar codi.

L'editor de codi, com es pot apreciar en la figura 19, té dues llistes desplegables
en la part superior. La de I’esquerra permet seleccionar qualsevol dels elements
existents en la pagina, moment en el qual la llista de la dreta enumerara els
esdeveniments que s’apliquen a aquest objecte. La seleccié d'un esdeveniment
provocara que l'editor generi la capgalera del metode encarregat de respondre
al succés, de manera que només cal introduir les senténcies que es volen exe-

cutar en aquest cas.

Figura 19. L’editor de codi de C#

00 NusvatplicacinWeb - Microsoft Visual Studio
File Edt View Project Buid Debug Team Data Tools Architecture Test ReShwper Anshze Window Hep
Pl Sl @ & DA9 -0 -8 P [ebug -1 | [togo.png - EE %

Bl D,

E=Stol= <]

Q%% % [R5 BOAI | 2 Ciet i Ok, 15| EE = w3 w4 w) )5 i Publish: | Creste Publizh Settings | %% 1 - i (3 Install Web Components

NuevoWebFormaspcs X

%5 NuevaAplicaciénWeb.NuevoWebForm -] 1% Page_Load(object sender, Eventirgs ¢)
using System; 2 forml

VPage_Load(object sender, Eventirgs ¢)

| =l e BN

23 Solution ‘NuevaplicacitniVeb' (1 project)
4 (A NuevahplicaciéaWeb

namespace NuevaAplicacidnieb

public partial class
{
protected void Page_Load(object sender, Lventirgs e)

{

}
}
}

0% - ¢

Q 0Erors | 1\ 0Wamings | (i) 0 Messages

Description File : Uine Column  Project

B Ervor List

Igual que l'editor XHTML/CSS, aquest ofereix també una serie d’ajudes enfo-
cades a facilitar el treball del programador, que es tradueixen en finestres flo-
tants amb informaci6 sobre els membres de 1’objecte el nom del qual s’ha in-
troduit, la llista de parametres que accepta el metode que es pretén invocar,
valors que es poden assignar a una propietat, etc.

A diferencia del que ocorre amb el codi XHTML/CSS, el codi C# no sera inter-
pretat ni executat durant la fase de disseny de 1’aplicacio, per la qual cosa no
tindra cap efecte sobre la interficie d'usuari que es construeixi paral-lelament

4 Properties
4 References
4 5 NuevoWebForm.aspx
%) NuevoWebForm.aspe.cs
9 NuevoWebForm.aspx.designer.cs
1§ Web.config

=3 Solution Explorer

aa 24
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en el dissenyador. Es tracta de codi que es processara en el moment en que
I'aplicacio sigui executada, i per aquest motiu s’emmagatzema en un modul
independent.

3.1.6. Execucid i depuraciéo d’un lloc web

Dues de les tasques basiques de qualsevol desenvolupador web sén 1'execucio
idepuraci6 del lloc en el qual treballa. Amb el Visual Studio, totes dues tasques
es fan molt facilment, la qual cosa és molt atil per al programador.

Per a executar un lloc web primer hem d’especificar la pagina en que s’iniciara
I'execucio, ja que podem tenir diverses pagines i en el Visual Studio estan totes
al mateix nivell. Per a especificar el punt d’entrada de 'aplicaci6 web premem
el boto dret sobre la pagina en qiiestio i seleccionem 1’opci6 Set As Start Page.

Figura 20. Establir com a pagina principal

Solution Explorer vOX
FEEEER
2\% NuevaAplicacion

=4 My Project
[ Account
(3 App_Data
[ Scripts

[ Styles

=] About.aspx
2] Default.aspx
&J Global.asax
=] NuevoWebForm.aspx
[7] Site.Master
3 Web.config

()

Open
Open With...
View Code

) W

View Designer

View Markup

View Component Designer

View Code Gen File

|} View in Browser Ctrl+Shift+W
Browse With...
Set As Start Page
Exclude From Project

& Cut Ctrl+X

S enncoee KRR o o0 -
X Delete Del

Rename

iz Properties Alt+Enter

Ara, quan executem el lloc web automaticament, el Visual Studio carregara la
pagina seleccionada. Per a executar el lloc web sense depuraci, ho podem fer
de maneres diferents:

e Seleccionant 'opci6é del mena Debug > Start Without Debugging.

e Prement Ctrl + FS.
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D’aquesta manera podrem veure la nostra aplicacié en execucid, pero no la
podrem depurar. Per a executar el nostre lloc web amb depuracié disposem de
diverses opcions:

e Prement el boté » de la barra de ment superior.

e Seleccionant I'opci6é del menta Debug > Start Debugging.

e Prement F5.

El Visual Studio disposa de multitud d’eines per a la depuracio6 del nostre codi.
Les més importants i Gtils per al nostre curs sén els breakpoints i els watch de
variables.

Un breakpoint, com ja devem saber, és la col-locaci6é d'una interrupci6 en el flux
d’execucio6. Per a col-locar un breakpoint en el nostre codi, tinicament haurem
d’anar a l’arxiu . cs i prémer amb el bot6 esquerre del ratoli sobre la columna

esquerra de la fila que vulguem (figura 21).

Figura 21. Breakpoint en |'arxiu de codi . cs

MuevoWebForm.asprcs®
“1§ NuevariplicacionWeb Muewo'WebFom

using System;

“Inamespace Huevadiplicacidnieb

{
public partlal class Nusvollebr : tem, 1. Foge
{
protected woid Page Load{object sender, Eventargs e)

i
H

- protected vold Buttenl Click{ebject sender, Eventirgs &)
{
o |[#
}

100 % -

Si llancem !’execucié amb depuracié del nostre lloc i cliquem sobre el bot6
podrem veure com el flux es para en el breakpoint que hem inserit (figura 22).
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Figura 22. Depuracié de I'aplicacié

Nuevo'WebForm.aspocs & X

Yt NuevahplicacidnWeb, Mueve\WebFarm
Susing Systes;

= namespace Nuevabplicacidnieb

{

public partial class NuewokWebForm : tem, I.Page

{

B protected vold Page Load{object sénder, Eventirgs e)

i
I

= protected vold Buttonl Click(object sender, Eventirgs a)
{ -
= 4 Labell.Text = “Depuranda™;|
b

e

Una vegada el breakpoint ha saltat, podem veure el valor de totes les variables
que tenim actualment en el nostre context. El valor de les variables el podem
consultar en l'apartat inferior Watch (figura 23).

Figura 23. Finestra Watch de variables

Watch1 vox
; Name Value ‘ Type o

B Output B Locals PARVERS B

Si fem doble clic sobre la columna nombre podem inserir el nom de la variable
que volem consultar i automaticament en la columna valor s’actualitzara el
contingut d’aquesta variable (figura 24).
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Figura 24. Inspeccié del valor d’una variable

Watch 1 vyvAXx
| Name | Value | Type -
7 Labell. Text Q +|string

B Output B Locals PRUEI B

Per a avangar el flux d’execucié una vegada parat en el nostre breakpoint, dis-

posem dels botons %= [Z de la barra de ment superior. Si avancem una linia
el flux d’execucié veurem com la variable canvia de valor automaticament
(figura 25).

Figura 25. Inspeccié del valor d’una variable

Watch1 vyOXx
| Name | Value | Type -
1 Labell . Text "Depurando” % ~| string

B Output B Locals PARVER B

Finalment, si volem reprendre 1’execucié normal de 1'aplicaci6, dnicament

hem de prémer una altra vegada el boto » .

3.1.7. Base de dades compacta amb el Visual Studio

En la majoria d’aplicacions web és necessaria una base de dades d’on s’agafa
la informaci6. Per a aplicacions extenses pot ser necessaria una base de dades
convencional que necessiti un servidor de base de dades per a funcionar, pero
per a projectes petits com son els nostres, una base de dades compacta (d'un
sol arxiu sense necessitat de servidor) és més que suficient. El Visual Studio
ens permet la creacié de tots dos tipus de base de dades des de l’entorn de

programacié mateix.
Creacio de la base de dades

Nosaltres ens centrarem en la creacié d’'una base de dades compacta mitjan-
cant el Visual Studio.

Primer de tot accedirem a l’apartat del menu Tools > Connect to Database. Se-
leccionem Microsoft SQL Server Compact 4.0 i premem OK (figura 26).
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Figura 26. Tipus de base de dades

(9 i

Change Data Source

Data source:

Microsoft Access Database File
Microsoft ODBC Data Source Use this selection to connect to a
Microsoft SQL Server Microsoft SQL Server Compact 4.0
database file.

Microsoft SQL Server Database File
Oracle Database

<other>

Description

Data provider:
’.NET Framework Data Provider for Micrc vl

[] Always use this selection ’ 0K l [ Cancel

En la finestra segiient, assignem un nom a la nostra base de dades en l'apartat
Database, com per exemple “NuevaBaseDatos”. En 1'apartat Password introdu-
im una contrasenya, com per exemple “uoc”, i premem Create (figura 27). Una
vegada creada la base de dades, premem OK i veurem com en el Database Ex-
plorer ens apareix una nova base de dades NuevaBaseDatos.sdf (figura 28).

Figura 27. Afegim la connexi6 a la base de dades

Add Connection m

Enter information to connect to the selected data source or click
"Change" to choose a different data source and/or provider.

Data source:
Microsoft SQL Server Compact 4.0 (NET Frame\

Data Source
© My Computer

ActiveSync Connected Device

Connection Properties

Database:

NuevaBaseDatos

Create... H Browse...

Password:

[] Save my password

Creacio de taules

Per a la creacio de taules, inicament haurem de prémer bot6 dret sobre Tables

i seleccionar Create Table (figura 29).

Database Explorer

20 %

4 () Data Connections
4 | [ NuevaBaseDatos.sdf
[ Tables
> [3 Replication

Lo RTINSO “a Database Explorer

Figura 28. Base de dades compacta
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Figura 29. Creaci6 de taules

Database Explorer vAax
2] | T
4[] Data Connections
4 [J; NuevaBaseDatos.sdf

N ‘%T Create Table
New Query
[2] Refresh
‘2 Properties Alt+Enter

LRSI 8 Database Explorer

A continuacié ens apareix una finestra en qué podrem especificar el nom i
els camps de la taula. Veiem que és molt semblant a altres gestors de bases de
dades; per a cada columna hem d’especificar el nom del camp, el tipus, si ha de
ser Unic, si pot estar buit i si és clau primaria. Una vegada emplenats els camps
premem OK (figura 30). Aixo ens generara la nostra primera taula (figura 31).

Figura 30. Formulari de taula nova

LTI,
, =

l vie |2) Refresh [ Help |
%7 General N
Name: PrimeraTabla
Column Name Data Type Length  Allow Nulls  Unique Primary Key
id int 4 No Yes Yes
s nombre nvarchar 100 Yes No No

Default Value
Identity False

Identity Increment

Is RowGuid False
Microsoft SQL Server Compact Precision
Scale
NuevaBaseDatos.sdf
Default Value

37 View connection properties Default value for this column.

[ o ][ conce

Database Explorer
(=11 | 5
4 [JJ Data Connections
4 % NuevaBaseDatos.sdf
4 | Tables
> [-Z] PrimeraTabla
> [ Replication

LSl 1 Database Explorer

Figura 31. Nova taula
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Ens queda poder crear claus foranes entre les nostres taules. Per a aix0 creem
una nova taula anomenada “SegundaTabla” (figura 32). Premem el bot6 dret
sobre aquesta taula una vegada creada i seleccionem 1’opcié Table Properties
(figura 33).

Figura 32. Edicié de taula

i

|2) Refresh [ Help |
%7 General U
Name: SegundaTabla
Column Name Data Type Length  Allow Nulls  Unique Primary Key
fid int 4 No No Yes
idPrimera int 4 No No No
Default Value
Identity False
Identity Increment
Is RowGuid False
Microsoft SQL Server Compact Precision
Scale
NuevaBaseDatos.sdf
Default Value
33 View connection properties Default value for this column.
View connection properties
OK ] I Cancel

Dins de les propietats anem a l'apartat Afiadir relaciones i emplenem els camps
d’aquest apartat tenint en compte que la columna esquerra correspon a la clau
primaria de la taula origen i la columna dreta correspon a la taula actual en
qué hem d’escollir la columna que sera clau forana. Premem Add Columns i
automaticament s’afegira la nova relaci6 de clau forana entre les taules (figura
34).

Database Explorer
B fEIR
4 () Data Connections
4 [J; NuevaBaseDatos.sdf
4 [ Tables
> [Z] PrimeraTabla

= e S

. [:J _R Drop Table

Table Properties

Edit Table Schema

New Query

Show Table Data

Copy Ctrl+C
Refresh

Properties

E:r\&i [T

Alt+Ente

Lo RTINS “a Database Explorer

Figura 33. Edici6 de taula
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Figura 34. Afegim la clau forana

|| %7 General
%F Column Create Relation
257 Add Relations Relation Name

F Manage Relations

Update Rule: Delete Rule:
NO ACTION -] [noacTion -
Primary Key Table Foreign Key Table
PrimeraTabla v SegundaTabla
Primary Key Table Column Foreign Key Table Column
(l
[id VI [idPrimera =
( Add Columns

Manage Rules in Relation

Selected Columns for Relation

Primary Key Table Column Foreign Key Table Column
id idPrimera
Microsoft SQL Server Compact
Delete Columns
NuevaBaseDatos.sdf
Add Relation

47 View connection

Insercié i edicio de dades

Una vegada creada la base de dades amb les seves taules relacionades, tinica-
ment ens queda inserir les dades necessaries. Per a aixd premem bot6 dret so-
bre la taula en que vulguem inserir dades i seleccionem 1'opcié Show Data Ta-
ble (figura 35).

Figura 35. Afegim dades a la taula

Database Explorer yAax
2] 1| %%
4 [} Data Connections
4 [J; NuevaBaseDatos.sdf
4 [ Tables
» =] PrimeraT--!~

» [Z] Segunda Drop Table
> [d Replication Table Properties
Edit Table Schema
New Query
[j Show Table Data
53 Copy Ctrl+C
[2] Refresh
i) Properties Alt+Enter
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Finalment veurem una taula que podrem editar afegint o modificant files a
parer nostre (figura 36).

Figura 36. Afegim dades a la taula

PrimeraTabla: Quer...uevaBaseDatos.sdf) X ]

id nombre

1 nombrel

2 nombre2
»# | NULL

Maneig de la base de dades des de codi

1) Seleccio de dades

Per a manejar la base de dades des del codi C#, ja sigui per a inserir, editar
o consultar, el primer que hem de fer és obrir una connexié amb aquesta. A
continuacié veurem un petit exemple en queé seleccionarem dades de la base
de dades i les carregarem en un desplegable.

Primer de tot definim en l’arxiu aspx el desplegable en que es carregaran les
dades i un bot6 per a llancar 1’esdeveniment que consultara la base de dades.

Figura 37

MNurwo'WebFormoa spat X NueeoWebForm.as

Client Dbjﬂ'll:& Events - (Mo Events)
<X§ Page Language="C#" AutoEventiireup="truve” CodeBehind="MuevakebForm.aspx.c:™ Inherits="Huevadppweb.NuevokebFora™ X

<!DOCTYPE html PUBLIC "=/ W3C//0TD XHTML 1.8 Transitiomal/JEN"™ “http://www.w3.org/ TR xhtmll/OTD/xhtmll=transiticnal.dtd™>

<hitm]l xmlns="http:/ ‘wew wl_org/ 1988 xhitm]l™ >
=l<head runat="seryer”>
<titlerg/titles
< fhead
=1 4 iy >
= <form ide"forml®™ runatsTserwver™>
cdive
<asp:Button runat="server” onclick="CargarDesplegable Click™ Text="Cargar Desplegable” />
<asp:DroplDownlist runmat="server™ ID="DrophownSelect” < fasp: 0ropDownlisty
<fdiv>
< forms
< hody >

< /html>

A continuacié en l'arxiu aspx.cs definim l’esdeveniment del boté6 amb
el codi de connexié i selecci6 de base de dades. Vegem como es de-
fineix la biblioteca de SQL Server Compact amb la instrucci6 using
System.Data.SglServerCe. Segons la versié del Visual Studio és possible
que no tingueu la biblioteca (dll) a la qual es fa referéncia. La trobareu en
I'espai de fitxers de l'aula.
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Figura 38
T e
1§ NuoalppWeb MecxWebForm = | ¢ CargarDesplogable Clickiobpect sender, EvertAngs &)
using Fystem.web.Ul.Heblontrols;
using Syites.Dets . 5glterverie;
NasESRAcE Hudyasppeh
{
public partial class
{
public static teetrings liztaTotal = new <ekring»();
protected vold Page Losd({cbject sender, )
{
protected wold Cargarpesplegable Click{obiect sender, targs &)
£
11 Con = AW ¢ Y (B Datadource="0: Wiers\Franclsce Ortege i Decusent s WiseveBateDatos . 40F " ; Pasawsrd="us"");
con. Open( )2
Lo = PEw CeCommand( “SELECT nosbere FROM PriseraTabla®™, con);
reader = com.ExeuteResder():
while {(reader.Read(})
OrophownSelect]. Ttems , add( new tesresder] “rosbre™ ], TeSteing( ) );
1
con.Close();
}
]

Comentarem linia per linia el codi que podem veure en l’esdeveniment de
botd del servidor:

SglCeConnection con = new SglCeConnection (@"DataSource='D:\Users\Francisco.Ortega\

Documents\NuevaBaseDades.sdf'; Password='uoc'");
Primer de tot connectem amb la base de dades amb la classe SqlCeConnec-
tionilipassem la ruta de l'arxiu de base de dades creat anteriorment i la seva
contrasenya.

con.Open () ;

Es necessari obrir la connexié amb la base de dades per a poder comengar a

fer-hi operacions.
SglCeCommand com = new SglCeCommand ("SELECT nom FROM PrimeraTaula", con);

Creem la consulta que farem en la base de dades amb l'objecte SqlCommand
i li passarem la connexi6 que hem creat.

SglCeDataReader reader = com.ExecuteReader () ;
Per a executar la consulta utilitzem la funcié ExecuteReader () . Aquesta fun-
ci6 ens retorna els resultats de la consulta que emmagatzemem en un objecte

de tipus SglCeDataReader.

while (reader.Read())
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DropDownSelect.Items.Add( new ListItem(reader["nom"].ToString()));

Anem recorrent el SqlCeDataReader amb un while extraient en cada itera-
ci6 una fila del resultat amb la funcié Read () . Una vegada extreta la fila accedi-
rem als camps de la base de dades mitjancant la notacié reader ["nomCamp"].

con.Close();

Una vegada fetes totes les operacions amb la base de dades tanquem la con-
nexi6 per no sobrecarregar la base de dades.

Si executem l’aplicaci6é podem veure com el desplegable es carrega amb la con-
sulta de la base de dades en prémer el bot6 Cargar Desplegable (figura 39).

Figura 39

|lo/®| 8 |
e )[@ hitp://tocalnost:4178/NuevowebForm.aspx o-Rex| Y

@ localhost

! Cargar Desplegable || Juan E] I

#®100% ~

2) Edici6 de dades

Per a I’edici6 de dades de la base de dades, igual que en la selecci6, hi haurem
d’obrir una connexié.

Continuant amb l'exemple anterior afegirem un TextBox, on inserirem el

valor que volem que reemplaci la selecci6é del desplegable.
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Figura 40

HuevoWebFormoaspe® = JEIaRaIUE

(hent Objects & Events - [Ma Events)
<X Page Languages"CE"™ dutoEventWireupe“true™ CodeBehinde“NuevodebForm.atpx.ct™ Inheritz="Nuevaippiieb.NusvokebForn” %>

<|DOCTYPE himl PUBLIC “-//W3C//0TD XHTHML 1.8 Transitiomal//EN™ “http://fwww.w3.org/TR/=htmll/DT0/xhtmll-transitional . dtd">

chtm]l welnss"http:/ wew Wi, org 1995 chital™>
—¢head runats” server >
titlexd/title»
€/ head>
= <body>
- iform id="forsl® runat="server®>
- <five
aspiButton renate"server™ onclick="CargarDesplegable Click™ Text="Cargar Desplegable™/>
<asptDropDownlist runat="server”™ ID="DropDownSelect™»< asp:DropDownlist>

caspiTextBox ID="TextBoxEditar™ runat="ferver < fatp:TextBoxs
<asp:Button renat="server™ onclick="EditarSeleccion_Click™ Text="Editar seleccidn™/>
o fdivs
& fForm>
« [ body >
& html»

A més, com podem veure, hem afegit un botd que llancara 1’esdeveniment

d’edici6 del camp del desplegable amb el valor del TextBox.
Figura 41

protected vold EditarSeleccion Click(object sender, Eventirgs )
{
SqleConnection con = mew Sqllefonnection{@™DataSources"D:\Users\Francisco.Ortega\Docusent s\MuevaBaseDatos. sdf "}
Password="woc ")
con.Open();
var itemSelected = DropDownSelect.SelectedItes;

if(15tring. IsNullOrEmpty | TextBoxEditar . Text))
{
SglCelommand com = new SqlCelommand(“UPDATE PrimeraTabla 5SET nombre=""+

TextBoxEditar.Text #°° WHERE nombres'"+ itemSelected.Text +°°[', con);:
com_ExecuteNonfuery();

}

con.Close();

Podem veure que la part de connexi6 i desconnexi6é amb base de dades és
idéntica a la de I'exemple anterior, i inicament varia la creaci6 i execuci6 de
la consulta.

SglCeCommand com = new SglCeCommand ("UPDATE PrimeraTaula SET nom='" +

TextBoxEditar.Text + "' WHERE nom='" + itemSelected.Text + "'", con);

Utilitzant el mateix objecte SqlCeCommand creem query d'Update passant-li
la connexié a la base de dades.

com.ExecuteNonQuery () ;
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Per a una edici6é de dades s’ha d’utilitzar la funcié ExecuteNonQuery (), en
lloc d’ExecuteReader ().

Si executem 1’aplicacid, veurem com si inserim un valor en el TextBox, selec-
cionem un valor en el select i premem Editar seleccion, el valor del desplega-
ble s’actualitza quan tornem a prémer Cargar Desplegable.

Figura 42
- - - - — e - | @ = J
C)l@ http://localhost4178/NuevoWebForm.aspx o-2ex| Y
= - Kl - —
@ localhost X
' Cargar Desplegable [Juan E Fran
®100% v

3) Inserci6 de dades

La inserci6 de dades és practicament idéntica a l’edici6. Continuant amb
I'exemple, afegirem un TextBox en que especificarem la cadena de caracters
que inserirem en la base de dades.

Figura 43

NueveWebFormoasps % Qrrm.;
| Chent Objects & Events -] (No Events)

«X§ Page Languages="C8™ AutoEventiireupstrue® CodeBehind=“NuevokebForm.aspx.cs™ Inherits="Nuevasppheb . NusvokebForm®™ s

<IDOCTYPE html PUBLIC “-//W3C//OTD XHTHL 1.0 Tramsitional/fEN™ “http://fwew.wd.org/TR/xhtell /OTD/xhtmll-transitional . ded™>

=l<html wmlns="http: /o . w3 . org/ 1999/ xhtml™>
—lthead runateserver™>
ctitlerd/ ritle>
o fhead>
--thﬂdy:
= «form ide"forml™ runat="server®:
Sdivy
<aspiButton runat="server” onclick="CargarDesplegable Click™ Text="Cargar Desplegable™/»
<asp:DropbDownList runate"server™ [Dw"DropDownSelect™»<fasp:DropDownLists

<asp:TextBox ID="TextBoxEditar™ runats="server »<fasp:TextBox»
<asp:Button runat="server® onclick="EditarSeleccion_Click®™ Text="Editar seleccidn™/»

casp:TextBox IDs"TextBoxInsertar™ runats™server™ »< asp: TextBox»
caspiButton| runat="server™ onclicke="Insertarfosbre Click® Text="Insertar nosbre™/»
< fdive
£ Sfares
< Moy >
<lhtml s
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A més, afegim un botd que llancgara 1’esdeveniment d’insercié en la base de
dades.

Figura 44

protected wvold Inzertarbosbre Click(cbject sender, Eventargs e)

{

& A% con = néw 5gqlce ect (B DataSource="D:Wiers\Francisco . Ortega\Document s \MivevaBaseDatos. sdf "

Password="udd" ")}

con.Open();

if (15tring. IsiullocEmpty [ TextBoxInsertar, Text))
.
i

i com = rew 1 d(“INSERT INTO PrimeraTabla (nombre)VALU

com.Parameters. Addwithvalue(“Enosbre™, TextBoxInsertar.Text);l
com. Executelonuery();

¥

con.Close();

El codi que varia pel que fa a I’edicié de dades és el que fa referéncia a la creacio
de la query d’insercié.

SglCeCommand com = new SglCeCommand ("INSERT INTO PrimeraTaula (nom)VALUES (@nom)",

com.Parameters.AddWithValue ("@nom", TextBoxInserir.Text);

Primer creem la query d’inserci6 especificant els valors que inserirem amb la
notacié @nomCamp. A continuacié especifiquem aquests valors amb la funci6
Parameters.AddWithValue () passant-li el @nomCamp identificat i el valor
que volem inserir. Si executem l'aplicacig, inserim un valor en el TextBox i
premem el bot6 Insertar nombre, veurem com s’insereix la cadena en la base

de dades. Per a poder veure-ho, recarregarem la combinacié prement Cargar

Desplegable.
Figura 45
- e =@ = |
w|@ http://localhost:4178/NuevoWebForm.aspx O-Be x| e
€ loclhost * . t|
GCargarDespegabe | ]

®100% ~

{@nosbre)™, con);

con) ;
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4. Introduccio a ASPNET

ASP.NET és una de les tecnologies que integra .NET mitjancant la qual els
desenvolupadors poden crear aplicacions web.

En aquest apartat s’explicaran les caracteristiques més destacables d’ASP.NET,
es fara una breu introducci6 historica des dels principis d’ASP.NET fins a
ASP.NET 4.0. A continuaci6, es comencara a veure una introduccio a la tecno-
logia ASP.NET, explicant el que sén els WebForm, els controls de servidor o
les MasterPage.

4.1. Caracteristiques principals d’ASP.NET

En ASP.NET hi ha set factors o caracteristiques clau que el diferencien dels
altres productes de Microsoft i de les plataformes de la competéncia. Aquestes

caracteristiques son les segiients:

1) ASP.NET esta integrat amb l’entorn de desenvolupament .NET Fra-
mework. I'entorn .NET Framework és un conjunt de milers de classes, estruc-
tures, interficies, etc., que esta organitzat segons la seva funcionalitat. La ma-
nera d’utilitzar les classes de .NET en ASP.NET és el mateix que en qualsevol
altre tipus de plataforma .NET. En altres paraules, la utilitzacié de l’entorn
de desenvolupament .NET és la mateixa en una aplicacié web que en una
d’escriptori. Aquesta caracteristica és veritablement important perque implica
que Microsoft ofereix les mateixes eines als desenvolupadors web que als pro-
gramadors d’aplicacions client.

2) ASP.NET és compilat, no interpretat. Les aplicacions ASP.NET, igual que
totes les aplicacions .NET, sempre es compilen. Aquesta compilacié passa per
dues etapes ben diferenciades. En la primera etapa, el codi C# es transforma en
un llenguatge intermedi anomenat Microsoft Intermediate Language (MSIL).
Aquesta etapa permet que les plataformes .NET siguin multillenguatge, és a
dir, que es puguin programar en diferents llenguatges de programacié com C#
o Visual Basic. La segona etapa de compilacio transforma el codi MSIL en codi
maquina. En la figura 46 podem veure un diagrama amb les diferents etapes
de compilacio.
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Figura 46. Etapes de compilacié d’ASP.NET

Codi en Codi Codi en un altre
VB.NET en C# llenguatge .NET

v v v

Compilador Compilador Compilador
VB.NET C# apropiat

¢ El Common
Codi IL Language
L—»| (llenguatge [¢— Runtime
intermedi)

v

Compilador
Just-in-time
JIT)

v

Codi
maquina
natiu

v

Execucio

3) ASP.NET és multillenguatge. Com hem vist, gracies a la primera etapa,
qualsevol plataforma .NET pot ser multillenguatge. Unicament necessitem un
compilador que transformi el llenguatge en el qual programem al llenguatge
intermedi MSIL. Els dos llenguatges de programaci6 per excel-léncia en .NET
son C# i Visual Basic.

4) ASP.NET és orientat a objectes. En ASP.NET es poden explotar totes les ca-
racteristiques d'una programaci6 orientada a objectes. Per exemple, es poden
crear classes reutilitzables, estandarditzar el codi utilitzant interficies o esten-

dre classes mitjancant ’heréncia.

5) ASP.NET és compatible amb tots els navegadors. Un dels principals des-
afiaments als quals s’enfronta un desenvolupador web és la gran quantitat
de navegadors que hi ha en el mercat. ASP.NET aborda aquest problema de
manera bastant innovadora: anima els desenvolupadors a utilitzar una serie
de controls de servidor. Aquests controls sén funcionals en clients només si
aquest suporten totes les seves caracteristiques.

6) ASP.NET és facil de desplegar i configurar. Un dels maldecaps principals
als quals s’ha d’enfrontar un desenvolupador és el desplegament d’una apli-

cacié web en un servidor real.
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7) Un altre aspecte destacable d’ASP.NET és la configuraciofacil, ja que tota la
plataforma esta unificada en un sol arxiu web . config. En aquest arxiu podem
configurar des de permisos d’accés a cadenes de connexi6 de base de dades.

4.2. L’evolucio d’ASP.NET

Quan Microsoft va llancar al mercat ASP.NET rapidament es va convertir en
I'estandard per a desenvolupament web amb tecnologia .NET i en un fort com-
petidor per a les altres plataformes de desenvolupament web.

Des de llavors, Microsoft ha creat diverses versions d’ASP.NET. En els subapar-
tats segiients s’explica com ASP.NET ha anat evolucionant als llarg dels anys.

4.2.1. ASPNET 1.0i1.1

La idea central d’ASP.NET va ser crear un model de pagines web anomenat
formularis web. Basicament, quan un navegador sol-licita una pagina ASP.NET,
crea en el servidor un objecte Page i tants objectes com controls tingui aques-
ta pagina. D’aquesta manera, el desenvolupador pot modificar aspectes de la

pagina en temps d’execucio.
4.2.2. ASP.NET 2.0

La versié 2.0 va mantenir el mateix model de formularis web i es va concentrar

en 'addici6 de caracteristiques noves d’alt nivell com:

® Pagines mestres. Les MasterPage o pagines mestres’ sén plantilles per a
la reutilitzacié de codi, com per exemple en encapcalaments o peus de
pagina.

e Navegacid. S'inclouen diferents controls de navegacié com l’arbre, el mapa
del lloc o els fils d’Ariadna.

e Seguretat. Inclou suport per a ’emmagatzematge de credencials d’usuari i

nous controls de servidor per a I'accés’, el registre d’usuari o el recordatori
de contrasenya.

e Origen de dades. La versi6 2.0 permet enllagar controls de servidor amb
diferents fonts de dades com bases de dades o XML.
4.2.3. ASP.NET 3.5

La principal novetat que es pot destacar de la versio 3.5 és la introducci6 de
dues noves tecnologies: Linq i Ajax.

©En angles, master pages.

©Fn anglés, login.
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La primera tecnologia és un conjunt d’ampliacions per a C# o Visual Basic que
permet manipular dades en memoria (per exemple, una llista) de la mateixa
manera que ho fariem amb consultes a una base de dades.

En les versions anteriors d’ASP.NET, per a cada peticié des del navegador, el
servidor havia de processar tota la pagina sencera i tornar-la a enviar al servi-
dor. Aquest procés resultava lent i ineficient, a més de ser poc interactiu des del
punt de vista de 'usuari. Per a solucionar aquest problema es va implementar
la tecnologia Ajax per a ASP.NET, que mitjancant JavaScript és capac de fer re-
carregues parcials d’'una pagina web. La figura 47 il-lustra les diferéncies entre
les peticions tradicionals i les peticions Ajax.

Figura 47. Peticions tradicionals i peticions Ajax

Actualitzacions normals de pagina amb ASP.NET

Petici6é d'actualitzacio

»
»

ASP.NET

&
<

Resposta amb la pagina completa

Actualitzacions de pagina amb Ajax

Peticio d'actualitzacio

»
»

ASP.NET

A

Resposta amb la porcié de pagina per actualitzar

4.2.4. ASP.NET 4.0

En la versi6 4.0 d’ASP.NET, les noves caracteristiques aportades sén una mica
més subtils. Alguna sén:

e Renderitzaci6 en XHTML. Després de processar la pagina corresponent a
la petici6, s’envia al client en 1'estandard XHTML.

e Control de ViewState. S'incorpora l'activacié/desactivacié del ViewState.
El ViewState és un objecte que ASP.NET va transmetent entre les crides

asincrones en qué s’emmagatzema informaci6 de la pagina.

e Control de grafics. S'incorpora un control per a la realitzacié de diferents
grafics com grafics de linies, barres, corbes, superficies, circulars, d’anells,
i grafics de punt.
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¢ Encaminament. Tecnologia per a poder redirigir peticions web igual que
fan la majoria dels patrons de disseny model-vista-controlador.

4.3. Estructura d’'una aplicaciéo ASP.NET

L'estructura d'una aplicacié web classica consisteix en una arquitectura cli-
ent-servidor segons la qual hi ha un servidor i un o diversos clients que hi
accedeixen (figura 48).

Figura 48. Arquitectura client-servidor

Client (navegador web) Servidor (servidor web)
Internet Explorer Sol-licitud s
Chrome Resposta httpd

Aquesta estructura és utilitzada també en una aplicacié ASP.NET. A més, les
aplicacions ASP.NET s6n executades en el servidor per una capa de progra-
mari, coneguda habitualment com a motor d’ASP.NET, que és l’encarregada
d’interpretar la sol-licitud que li facilita el servidor web i generar un objecte
HttpRequest amb tota la informacié. En aquest objecte estaran contingudes,
per exemple, totes les dades introduides en els formularis per l'usuari, el na-
vegador utilitzat o la informaci6 d’estat de 1’aplicacio.

Cada pagina d’un projecte ASP.NET es compon almenys de dos moduls: un
amb extensi6 .aspx, en el qual esta contingut el codi XHTML estatic, i un
altre amb l'extensi6 .aspx.cs, que allotja el codi C# corresponent a la logica
de l'aplicaci6.

La primera vegada que es rep una sol-licitud per a una pagina, el motor
d’ASP.NET la compila i obté una versi6 llesta per a executar-se, que s’allotja
en memoria. En les sol-licituds segiients la resposta sera immediata, ja que es
disposa d'una versié compilada.

En la figura 49 es pot veure un esquema de blocs dels elements que formen
una aplicaci6 ASP.NET. Com es pot veure, el client sempre obtindra com a
resposta una combinacié d’XHTML, CSS i JavaScript, llenguatges valids per a
qualsevol navegador web amb independéncia de la plataforma que s’utilitzi

per a fer la peticio.
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Figura 49. Arquitectura ASP.NET
Client (navegador web)

XHTML .
CSS Sol-licitud
Javascript
Servidor (1IS)
A
HttpRequest
Resposta

MOTOR
ASP.NET

HttpRequest

Compilador
C#

.aspx.cs

4.3.1. Tipus d’arxius en ASP.NET

Les aplicacions web en ASP.NET poden tenir diferents tipus d’arxius, alguns

dels quals es mostren a continuacio:

e _aspx:son les pagines web en ASP.NET. Contenen la interficie d'usuari. El

punt d’entrada per als usuaris sempre és un d’aquests arxius.

® .ascx:sOn els controls d’usuari en ASP.NET. S6n similars a les pagines web,
pero no soén accessibles directament des del navegador, siné que sempre

formen part d’'una pagina. S’utilitzen per a reutilitzar codi i evitar-ne aixi

la repeticid.

* web.config: arxiu de configuracié en XML. Des d’aqui es configuren as-

pectes de seguretat, memoria, connexions a bases de dades, etc.

* global.asax: és el fitxer global de l'aplicaci6. Aqui es poden definir vari-
ables globals, accessibles des de qualsevol pagina, i esdeveniments propis

de l'aplicacid.

e _cs: arxiu de codi C#. Ens permet separar la logica de ’aplicaci6é de la
interficie d’usuari.

A més d’aquests arxius, les aplicacions ASP.NET en poden contenir d’altres
de comuns en moltes aplicacions web, com arxius JavaScript, HTML, CSS o

imatges.
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4.4. Que son els WebForm?

Les Pages o, com oficialment es coneixen, els WebForm, sén la part més im-
portant d'una aplicacié ASP.NET. Aquests WebForm generen tot el codi HTML
de resposta a qualsevol peticié que sol-licita un client des del navegador. Ca-
da WebForm que afegim a la nostra aplicaci6 sera una pagina accessible per
l'usuari. Un WebForm esta compost per dos arxius de codi, un arxiu .aspx,
on hi ha tot el codi de la interficie d’usuari, i un arxiu .aspx.cs, amb tot el

codi relacionat amb el WebForm com esdeveniments, validacions, etc.

A continuaci6é podem veure un exemple d'un WebForm en qué es mostren

tots dos fitxers:

Figura 50. Arxius .aspx i .cs d'un WebForm

| Client Objects & Events -
<&@ Page Language="(#" AutoEventWireup="true"” CodeBehind="NuevoWebForm.aspx.cs™
Inherits="Nuevafplicacidnieb.NuevolebForm" %>

<!|DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8 Transitional//EN"
"http:/ vww. w3, org/TR/xhtml1/DTD/xhtmll-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml">
<head runat="server"”>
<titles</titles
¢/head>
<body>
¢<form id="forml" runat="server">
<div>

<fdiv>

</form»
</body>
</html>

NuevoWebForm.aspr.cs X ISR 6T T

“§ NuevaAplicacionWeb.NuevoWebForm - l 5

Husing System;

5

[=inamespace NuevaAplicacidnWeb

=] public partial class NuewvolebForm : System.Web.UI.Page
{
- protected void Page_lLoad(cbject sender, Eventirgs e)
{
}
}

Internament, un WebForm o Page es genera gracies a la classe Page, com hem
pogut veure tant en la capgalera del fitxer .aspx com en 'heréncia del fit-
xer .cs. Posteriorment es dedicara un apartat a explicar més profundament
aquesta classe, una de les més importants de la biblioteca de classes de .NET.
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4.4.1. Afegir un WebForm al nostre lloc web

Per a afegir un WebForm a un lloc web creat préviament, inicament hem de

seguir els passos segiients:

e Premem el bot6 dret sobre 'arrel del projecte, o sobre qualsevol carpeta
en que vulguem que s’allotgi el WebForm, per a obrir el ment contextual,
i a continuaci6 premem Add > New item.

e A continuacio seleccionem la plantilla WebForm, donem un nom a la nos-

tra pagina i premem Add.

Figura 51. Afegim un WebForm

Add New Item -

Installed Templates

4 Visual Basic
Code
Data
General
Web
Silverlight

Name:

Online Templates

T F R w00 e =

Web Form using Master Page

Web User Control

Class

Master Page

Nested Master Page

HTML Page

Style Sheet

JScript File

AJAX-enabled WCF Service

ASP.NET Handler

ASP.NET Module

ASP.NET Server Control

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic

Visual Basic ™

NuevoWebForm.aspx

[ search Installed Templates

2|

Type: Visual Basic
Aform for Web Applications

Cancel

Introduccié a ASP.NET
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e Si despleguem en el Solution Explorer el nostre WebForm podem veure els

arxius .aspxi .aspx.cs.

¢ Finalment podem explorar tots dos arxius en I'Editor de codi corresponent
fent doble clic en cadascun.

4.5. La classe Page

Cada pagina d’una aplicacié web en ASP.NET hereta de la classe Page. Mitjan-
cant aquesta heréncia les nostres pagines adquireixen una serie de propietats
i metodes que podem utilitzar en els fitxers .cs.

A continuaci6é enumerarem alguna de les propietats més importants:

e IsPostBack: boolea que indica si és la primera vegada que la pagina s’ha
carregat.

e EnableViewState: boolea. Ens permet decidir si volem desar la informa-

ci6 d’estat dels controls entre peticions.

e Application: collecci6 que conté informacié compartida entre tots els

usuaris del lloc web.

® Session: col-lecci6 que conté informacié d’un usuari en particular que es

manté entre diferents peticions.

* Request: col-leccié que conté informacio6 sobre la peticié actual, com in-
formaci6 del navegador o els parametres enviats.

¢ Response: objecte HttpResponse relacionat amb la resposta a una peti-
ci6 determinada. Es pot utilitzar per a encaminar 'usuari a una altra pagi-

na, enviar cookies al navegador, etc.

Un cas molt coma en que s’utilitza una propietat de la classe Page és en
I’encaminament del flux cap a una altra pagina web. Concretament, s’utilitza

la propietat Response.

Per a veure’n un exemple inserirem en un WebForm dnicament un Button

amb el seu esdeveniment de servidor respectiu.

Solution Explorer vyaXx

5‘ 5| e
2 Solution ‘NuevaAppWeb' (1 project)
E;% NuevaAppWeb

=d| Properties

«3] References

[ Account

3 App_Data

[ Scripts

3 Styles

@ About.aspx

@ Default.aspx

4] Global.asax

@ NuevoWebForm.aspx
%) NuevoWebForm.aspx.cs
%] NuevoWebForm.aspx.designer.cs

[7] Site.Master

i Web.config

_j LY SIS % Team Explorer

Figura 52. Afegim un WebForm
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Figura 53. Codi . aspx d'un WebForm

|  Client Objects & Events -] (Mo Events)

age Language= AutoEventiireup="true” CodeBehind="NuevolebForm.aspx.cs
Pag guage="C#" AutoE ireup="true" CodeBehind="H bF .
Inherits="NuevafAplicacidnieb.NuevoiebForm™ X>

<[DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN™
“http:/ St w3. org/ TR/ xhtmll /DTDS xhtmll-transiticnal .dtd"»
Sl<html xmlns="http://wew.w3.org/1999/xhtml ">
=l<head runat="server">
<titler</ritles
</head>
—l<body>
= <form id="forml® runat="server":»
=] <div:
<asp:Button ID="Buttonl® runat="server" Text="Button®™ /»
<fdiv>
</form>
| </body>
| </html>

Figura 54. Codi . cs d'un WebForm

TR T L PR el MuevoWebForm.aspx®

“t NuevafplicaciénWeb.MueveWebForm =|#¥Bu
Slusing System;
zing S em.Collections.Generic;

-Inamespace NuevaAplicacidnieb

= public partial class NuevolebForm : System.Web.UI.Page
{
= protected void Page Load(object sender, Eventargs e)
{
}
= protected woid Buttonl Click(object sender, Ev
i
¥
i
}
W% - 4

En l'esdeveniment click del bot6 fem un encaminament cap a una altra pa-
gina web de la manera segiient:
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Figura 55. Codi . cs d'un WebForm

MNueveWebForm.aspr.cs™ X

| i MuevaAplicacionWeb. MuevoWebForm 'I % Butte
Elusing System;
using System.Collections.Generic;

em.Ling;
em.Web:
using 5 JHeb.UI;

using System.Web.UI.WebControls;
~Inamespace Muevadplicacidnieb

= public partial class NuevokebForm : System.Web.UI.Page

i
=] protected void Page Load(cbject sender, Eventirgs e)
{
H
= protected vold Buttenl Click(object sender, Eventirgs e)
{
Response.Redirect("http://www.google.es") ;|
}
| 1
L}
0% = -«

Si ho executem, veurem que quan premem en el bot6 (figura 56) el flux
s’encamina cap a 'URL que hem posat en el Response.Redirect (figura 57).

Figura 56. Execucié d’un WebForm
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x ‘.- (B DabagBar @-l‘:‘t &~ g ::-|1m - 9- Q' s E vl' 3 -
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Figura 57. Execucié d’un WebForm

-

i |
- . - - —
\jl"l http://www.google.es/ o-ex| & ¥

*3 Google x
X 84~ | (B DebugBar @~ |
o v [ déh v Pagev Safetyv Toolsv @

D] @ ~| & | 53] 190% v| G~ & v ® | BuscarenGooge | Destacarenla pagina -
RURON:]

No, gracias

Acceder ' ¥

Una forma mas rapida de navegar la web.
G Instala Google Chrome

(T

Buscar con Google Voy a tener suerte

®100% v

Aquest exemple ens pot servir per a fer encaminament entre les pagines del
nostre lloc i aixi poder navegar-hi.

4.6. El ViewState

En una aplicacié d’escriptori de Windows, una part de la memoria de
I'ordinador és utilitzada per a emmagatzemar-ne 'estat. En una aplicacié web,
el funcionament és totalment diferent. Un client es connecta al servidor web,
sol-licita una pagina i la connexi6 finalitza quan la pagina es lliura, i es des-
carten tots els objectes que hi hagi en memoria. Per aquesta rad, sorgeix el
problema de 'emmagatzematge de certa informacié de l’estat de 1’aplicacio
entre diferents peticions d’un client.

Una de les maneres d’emmagatzemar aquesta informacié en ASP.NET és fer-
ho en el ViewState. ASP.NET insereix automaticament el ViewState com un
camp ocult en cada renderitzacié HTML d’una pagina. D’aquesta manera es
conserven les dades entre diverses peticions de servidor.

A continuacio (figures 58, 59 i 60), podem veure un exemple d'un comptador
que emmagatzema les vegades que un usuari prem un boto.
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Figura 58. Codi . cs d’un ViewState

| dlient Objects & Events | (No Events)
¥ Page Language="C&" AutoEventWireup="true” CodeBehind="NuevolWebForm.aspx.cs™
Inherits="Nuevaiplicacidnieb.NuevokebForm™ %>

<IDOCTYPE html PUBLIC "=//W3C//DTD XHTML 1.8 Transitional//EN"
"hittp:/Sew w3 org/ TR/ xhtml1/DTD/ xhtmll-transitional . dtd">
Fl<html xmlns="http:/ /www.w3.org/1999/xhtml">
=l<head runat="server®:
<titler</ritles
< heads
=l <body >
= <form id="forml® runat="server"»
=] <div>
<asp:lLabel ID="Labell™ runat="server" />
<asp:Button ID="Buttenl®” runat="server"” Text="Button”/:
<fdivy
| < fform>
| </body>
</html>

0o%e - + 1

Figura 59. Codi . cs d’'un ViewState

MuevoWebForm.aspiees

“§ NuevaAplicaciénWeb.NuevoWebForm -] ¥ Pac
[Fusing System;
using System.Collections.Generic;

[Fnamespace Nuevahplicacidnieb

{
= public partial class NuevokebForm : System.Web.UI.Page
{
= protected void Page Load(object sender, Eventirgs e)
i
if (ViewState["contador™] == null)
i
ViewState["contader™] = @;
3
else
{
ViewState["contader™] = (int)viewState["contador”] + 1;
Labell.Text = ViewState["contador"].ToString();
X

100 % - 4
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Figura 60. Execucié d'un ViewState
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4.7. Controls de servidor

ASP.NET va introduir fa diversos anys un model innovador per a la creaci6
de pagines web. Anteriorment, per al disseny de pagines web dinamiques
s'introduien etiquetes en el fitxer HTML mateix i, segons la interpretacio
d’aquestes etiquetes, es produia una sortida d’'HTML o una altre. Aquesta tec-

nica, a més de resultar tediosa, produia un codi poc extensible i reaprofitable.

ASP.NET va solucionar aquest problema introduint el concepte de controls de
servidor.

Els controls de servidor es creen i es configuren com a objectes. Una ve-
gada configurats per part del desenvolupador generen automaticament
el seu codi HTML propi.

Algunes caracteristiques dels controls de servidor sén:

e Generen la seva interficie d'usuari propia. Es genera el codi HTML en
temps d’execucio i s’envia al client.

e Retenen el seu estat. Desen informaci6 d’ells mateixos entre diferents pe-

ticions.

¢ Disposen d’esdeveniments de servidor. Per exemple, un bot6 pot executar

una funcié de servidor en ser premut.

ASP.NET ofereix una gran quantitat de controls de servidor, que es poden clas-
sificar en diferents grups. Tots els trobarem en el Toolbox de Visual Studio.
Alguns dels grups més importants son:
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a) Controls de servidor HTML: grup en que trobem els elements HTML estan-
dard com els enllacos (<a>), els inputs (<input>), etc. Per a convertir un ele-
ment HTML estandard en un control de servidor, inicament hem d’indicar

I’atribut runat=server.

b) Controls web: controls amb les mateixes funcionalitats que alguns elements
HTML, pero que disposen de propietats i métodes que en faciliten la declaraci6é
i accés. Alguns exemples sén Hiperlink, ListBox, Button, etc.

¢) Controls Rich: controls que amplien les funcionalitats dels elements HTML
i fins i tot sén capacos de generar codi JavaScript propi. Un exemple és el
TreeView.

d) Controls de validacio: controls que permeten aplicar normes o regles a les
entrades de dades dels usuaris.

e) Controls de dades: controls dissenyats per a mostrar grans quantitats de
dades i per a I’edicid, ordenaci6 i paginacié d’aquestes. L'exemple més clar és
el control GridView.

f) ASP.NET Ajax Controls: aquests controls permeten al programador utilitzar
la tecnologia Ajax sense necessitat d’escriure codi JavaScript en el costat del

client.

4.7.1. Controls de servidor HTML

Com hem dit, els controls HTML sén exactament iguals que els elements
HTML comuns. El podem trobar tots en el Toolbox, dins de I'apartat HTML

(figura 61).

Si arrosseguem qualsevol control HTML i el deixem anar en el dissenyador de
pagines veurem com automaticament es genera el codi HTML corresponent.

Toolbox vyAaXx
> Reporting -
4 HTML
R Pointer

(O Input (Button)
@ Input (Reset)

#) Input (Submit)
[sb] Input (Text)

[abl  Input (File)

#%  Input (Password)
Input (Checkbox)
Input (Radio)
Input (Hidden)
Textarea

Table

©F

m

Image

Select

0G0 B E RS E

Horizontal Rule
Div

4 General

There are no usable controls in this
group. Drag an item onto this text to
add it to the toolbox.

Figura 61. Controls HTML
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Figura 62. Codi . aspx d’un control HTML

| Glient Objects & Events -
<%@ Page Language="C#" AutoEventWireup="true” CodeBehind="HuewvonebForm.aspx.cs”
Inherits="NuevaApphieb. NuevoklebFore™ X>

<IDOCTYPE html PUBLIC ~-//W3C//DTD XHTML 1.8 Transiticnal//EN"
“http: /S w3 org/ TR xhitell /DTO xhtmll -transiticnal . dtd"™ >

=dhtml xmlns="http: /S vwew.wd. org 1999 whiml ™ >
=<head runat="server”?
<titler<Stitle»
< head>
= <body>
= <form id="forml” runat="server®:
= <dive
<input id="Textl" type=T"text" /»
<fdivy
</form»
</body>
| <html>

W% - ¢

Per a convertir ’element HTML en un control de servidor, tnicament hem

d’afegir 'atribut runat = server.

Figura 63. Codi . aspx d’un control HTML

| Client Objects & Events | e
<%@ Page Language="C#" AutcEventWireup="true” CodeBehind="HuevoWebForm.aspx.cs”
Inherits="NuevaAppkeb.NuevokebFora™ >

<IDOCTYPE html PUBLIC =-//W3C//DTD XHTHML 1.8 Transiticnal//EN"
“http: S S w3 . org/ TR xhitell /DTD xhtmll-transitional . dtd™ >

Hihtml xmlns="http: /v wd . org 1998/ xhiml ">
Hihead runat="server”y
<titler<Stitle»
<fhead>
=<body>
= <form id="forml™ runat="server":
B <dive
| Binput id="Text1" type=“"text” runat="server=/§
< fdive
</form»
</bady>
| </html>

100 % = 4

Des d’aquest moment hi podrem accedir des de l'arxiu de codi (. cs) mitjan-

cant el seu id i modificar-ne les propietats.
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Figura 64. Codi . cs d’'un control HTML

NuevoWebFormeaspr.cs™ > JUIITRERTR T Default.aspx

%5 MuevahppWeb NueveWebFam -[ ¥Pag

—lusing System;

-|namespace NuevaAppheb

{
public partial class MuevckiebForm t Page
{
protected void Page Load(object sender, enthArgs e)
{
Textl.Visible = false;
H
}
}

0% - 4

Si executem l’aplicaci6, podrem veure que el nostre element no és visible, ja
que hem aplicat la propietat visible = false.

4.7.2. Controls web

Els controls de servidor HTML proporcionen una manera relativament rapida
de migrar HTML a ASP.NET, pero no és necessariament la millor. D'una banda,
els controls HTML i els seus atributs no sempre tenen uns noms intuitius, i
tasques com aplicar estil al control poden resultar tedioses.

Per a resoldre aquests problemes ASP.NET posa a disposicié nostra els controls
web, que basicament generen el mateix HTML que els controls de servidor
HTML, pero disposen d'una configuracié molt més senzilla.
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Els controls web estan disponibles en el Toolbox dins de l'apartat Standard Toolbox .
(figura 65) 4 Standard =
R Pointer
9 AdRotator
Si arrosseguem, per exemple, el control web Button i el deixem anar en I’editor z“l':‘ed““
utton
de codi veurem que, com amb els controls HTML, es genera un bloc de codi B2 Calendar
per defecte. CheckBox
8= CheckBoxList
&3 DropDownlList
Figura 66. Codi . aspx d’un control web t,  FileUpload
= bl HiddenField
| Client Objects & Events . . | Mok A Fyperink
«X@ Page Langu::ge-'t#" AutoEventiWireup="true” CodeBehind="NuevchebForm.aspx.cs” & Image =
Inherits="Nuevaippkeb.NuevokiebFora™ %>
ImageButton
<IDOCTYPE himl PUBLIC =-//W3C//DTD XHTML 1.8 Transiticnall//EN" §  ImageMap
“http: /Swew. w3 . org/ TR/ xhtell /OTO xhtmll-transitional .dtd™ > A Label
=¢html xmlns="http:/Swew. wd. org 1999 xhiml "> LinkButton
= <head l_'umr-"sv._'.nrl:r':- [E5  ListBox
<,rh:;:1t1“dutlt? B Literal
= <body> @ Localize
= ¢form id="forml" runat="serwver™: @ MultiView
= <div> 1 Panel
i gasp:Button ID="Buttonl™ runat="server” Text="Button™ .l')l —
<fdivy <l PlaceHolder L)
<[ farm> ® RadioButton
</body > 2= RadioButtonList
</heal> ia) Substitution
[ Table
[abl  TextBox
O View
% Wizard
E  Xml
1> Data <
0% « 4 Figura 65. Controls web

Si modifiquem una de les propietats, com per exemple Height, i executem
el lloc web, veurem com automaticament s’aplica el valor que hem indicat a
I’alcada del boté.
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Figura 67. Codi . cs d'un control web

| Glient Objects & Events | (Mo Ever

<X§ Page Language="C#" AutoEventWireup="true” CodeBehind="NuevokebForm.aspx.cs”
Inherits="NuevaApphieb.NuevoklebFora™ X

<IDOCTYPE himl PUBLIC ==/ W3C//DTD XHTML 1.8 Transiticnal//EN™
“http: /S, w3 . orgS TR xhtell /OTDS <himll-transiticnal. dtd" >

=<html xmlns="http:/ wew. w3 . org/ 1999/ xhtml ">
=<head runat="server”>»
ctitler</title>
<fhead:
= <body>
- <form id="forml™ runats"server”:s
- <divy
gazp:Button ID="Buttonl™ runat="server” Text="Button™ Hrigﬂ‘.z"ilﬁﬁ"f’}
<fdive
</ farm>
<fhady>
< html>

Wi% = ¢

Figura 68. Execucié de I'exemple d’un control web

o+ M - . — eSS~
( *r“\ﬂ‘l@ http:/localhost:4178/NuevoWebForm.aspx o-2ex| vy
[ & tocathost x — -

x 83~ | Eoebugtr &~ | D] @ | £ | [ 100% -] G- B - D8 0 - M

Bov B v @ v puger Steyr Tookv @ 33 8 M O B

®100% ~

Com hem pogut observar en l'exemple dels controls web, podem accedir a
les propietats des del dissenyador de pagines, mentre que en 1’exemple dels
controls HTML ho feiem des de l'arxiu adjunt .cs. Aquest és un altre dels
avantatges d’utilitzar els controls web en lloc dels controls HTML.

4.7.3. Controls Rich

Els controls Rich o Rich controls ens aporten complexes interficies dusuari.
Aquests controls ens ofereixen funcionalitats molt més amplies que els con-
trols HTML o web. En realitat cada control Rich és un conjunt de controls web
que utilitzem com un de sol. L'exemple més clar és el del control Calendar,
que esta compost per Buttons, Labels o Hyperlinks.
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Els controls Rich els trobem en 1'apartat Standard del Toolbox. Concretamentn
alguns dels controls Rich més importants son:

e (Calendar: calendari que permet navegar entre mesos, dies o anys.

e Multiview i View: permeten implementar diferents vistes en una mateixa
pagina i navegar-hi.

e AdRotator: baner per a mostrar una serie d’imatges.

De nou arrossegarem un control d’aquest tipus, concretament un Calendar, i
el deixarem anar en el dissenyador. Veiem que, encara que internament esta
compost per diversos controls web, inicament es genera una etiqueta Calen-
dar (figura 69). Fem el mateix amb un control web Label, que ens servira per

a mostrar el dia seleccionat.

Figura 69. Codi . aspx d'un control Rich

| Glient Objects & Events -| (Mo Event:
<X Page Language="C#" AutcEventWireup="true” CodeBehind="HuevoWebForm,aspx.cs”
Inherits="Nuevaippkeb. NuevolebFore™ X»

<IDOCTYPE hitml PUBLIC =-//W3C//DTD XHTHML 1.8 Transiticnal//EN"
“http:s S wew. wd.orgd TR xhtell/0T0 xhtmll-transiticnal .dtd™ >

<himl xmlns="http:/ v w3 . org 1998/ xhiml " »
<head runat="server™s
<titled</title>
</head>
= <body»
<form id="forml™ runat="server":
<divy
<asp:Calendar ID="Calendarl™ runat="server“»<fasp:Calendar>
<asp:Label ID="Labell" runat="seérver” Text="Label"»<fasp:Label>
<fdive
< ffarm>
</bady >
<fhtmls

W% = 4

Igual que en els controls web, podem modificar propietats o afegir esdeveni-
ments tant des del dissenyador com des de l'arxiu adjunt .cs.

A continuaci6, en el dissenyador, en la finestra de propietats des de l’apartat
d’esdeveniments, fem doble clic sobre I'esdeveniment SelectionChanged.
Aix0 ens generara automaticament un esdeveniment que es disparara en can-

viar el dia seleccionat.
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Figura 70. Finestra de propietats del control

Properties vyAXx
Calendarl System.Web.ULWebControls.Calendar -
o= 2hfiEl # S

4

DayRender

SelectionChanged Calendarl_SelectionChanged [Z]

VisibleMonthChanged

DataBinding

Auto Format...

SelectionChanged
Fires when selection is changed by the user.

Dins de la funcié selectionChanged escrivim el codi que ens actualitzara el
control web Label amb la data seleccionada.

Figura 71. Codi . cs d’un control Rich

I “ Mueva App'Web.MuevoWebForm 'l j‘u:illtndé
Susing System;

Sy stem. Ling;

= namespace NuevaAppheb

! public partial class NuevorebForm @ System.wWeb.UL.Page
: protected void Page Load(cbject sender, Eventérgs e)
{
¥
= protected void Calendarl SelectionChanged(cbject sender, Eventargs e)
Labell.Text = Calendarl.SelectedDate.ToString();
}
¥
00% = ¢

Executem i comprovem que mentre anem canviant la selecci6, 1’etiqueta es
va actualitzant correctament.
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Figura 72. Execucié de |'exemple d’un control Rich
&= HY¥il«a D B g -

& 1R @ | £ -] -]

o~ - Pagev Safety~v Toolsv @~ §3 N W]
< noviembre de 2011 >

lun mar mié jue vie sab dom
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4 15 16 17 18 19

21 22 23 24 25 26 27

28 29 30 1 2 3 4

3 6 71 8 9 101
20/11/2011 0:00:00

®100% ~

4.7.4. Controls de validacid

Un de les funcionalitats més comuna de les pagines web és recollir dades in-
serides pels usuaris. Sovint, una pagina web demana dades a un usuari, que
finalment seran desades en una base de dades. En la majoria de casos aquestes
dades han de ser validades per a assegurar que no s’emmagatzema informa-
ci6 incoherent. Idealment, la dada entrada per l'usuari ha de ser validada en
el client, mitjancant JavaScript, i en el servidor, en el nostre cas mitjancant
ASP.NET.

Per no haver d’escriure el codi de validacié manualment, que seria una tasca
bastant laboriosa, ASP.NET disposa de sis controls de validacio:

® RequiredFieldvalidator: prova siel control relacionat esta buit quan
s’envia el formulari.

e RangeValidator: comprova que l'entrada de l'usuari estigui dins d'un

rang determinat.

e CompareValidator: prova que el valor del control compleixi una condi-

ci6 determinada (més gran que, més petit que, igual que).

¢ RegularExpressionValidator:comprova que el valor d'un control de-

terminat compleixi una expressio regular.

®* CustomValidator: permet al desenvolupador especificar una funcio cli-
ent i una de servidor que validaran l’entrada de 1'usuari.

e ValidationSummary: proporciona una regié amb els errors de tots els

validadors de la pagina.



CC-BY-SA « PID_00194031 66 Introduccié a ASP.NET

Aquests controls fan la major part del treball i el programador solament els Toolbox E——
ha de configurar perque funcionin correctament. Podem trobar tots aquests 4 ;‘at"da'd
> Data
controls en el Toolbox dins de la seccié Validation (figura 73). 4 Validation
R Pointer
%y CompareValidator
Per a provar com funciona un control de validacid, primer hem d’inserir el &  CustomValidator
N &y R Validat
control en la pagina, de manera que arrossegarem un TextBox des del Toolbox v TengerendEer
#% RegularExpressionValidator
fins a ’editor. &  RequiredFieldValidator
(_] ValidationSummary
> Navigation
Figura 74. Codi . aspx d’un control de validacié ST =
> Login
> WebParts
i Obi - o] il
I BB sl > AJAX Extensions

X8 Page Language="C#" AutoEventhireup="true” CodeBehind="NuevoWebForm,aspx.cs”

Inherits="NuevaAppkeb.NuevokiebFora™ %> > Dynamic Data

> HTML
<IDOCTYPE html PUBLIC ~-//W3C//DTD XHTML 1.8 Transitional//EN" 4 General
“http: /et w3 orgd TR xhtel1/0TD xhtmll-transiticnal . dtd™>

chtml xmlns="http://wer. w3, org/1999 / xhtal"> Thgre are no usable _controls in
this group. Drag an item onto

chead runat="server”: this text to add it to the toolbox.
<titler</title>
¢/head>
= <bady>
<form id="forml™ runats="server”:
<divy
gasp:TextBox ID="TextBoxl" runat="server”»{/asp:TextBoxd
<fdiv>
< ffarm>
<.-"I:cd:.'>
</html>

Figura 73. Controls de validacié

100% = ¢

A continuaci6 arrosseguem el control de validacié que vulguem aplicar, com
per exemple, un RangeValidator, i en configurem els atributs segiients:

e ErrorMessage: error que apareixera quan la validaci6 falli.

¢ MaximumValue: valor maxim que es pot introduir.

¢ MinimumValue: valor minim que es pot introduir.

e ControlToValidate: ID del control sobre el qual s’aplicara la validacio.

Finalment, arrosseguem un Button a la nostra pagina, amb el qual farem

I’enviament del formulari.
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Figura 75. Codi . aspx d’un control de validacié

| Giient Objects & Events =] (Mo Events)
«X@ Page Language="C#" AutoEventiWireup="true” CodeBehind="NuevowebForm.aspx.cs™
Inherits="NuevaAppieb.NuevokebFora™ X>

<IDOCTYPE html PUBLIC =-//W3C//DTD XHTHL 1.8 Transiticnall/EN"
“http:/ S, w3 org/ TR/ xhtell /DTO/ <htmll-transiticnal . dtd">

=<html xmlns="http://wew.wd.org/ 1995/ xhtml">
=<head runat="server™»
<titler</title>
</head>
= <bady>
= <form id="forml® runat="server™>
- <divy
casp:TextBox ID="TextBoxl" runst="server”»¢ /asp:TextBox>
<aspiRangevalidator ID="Rangevalidatorl™ runat="server” Errortessages"El valor estd fuera de los limites®
MaximesValue="58" Minimumvalue="18" ControlToValidate="TextBoxl"»</asp:RangeValidators
casp:Button ID="Buttonl™ runat="server” Text="Butten™ />
<fdivs
</form>
< /body>
< /html>

% -

Si executem la nostra pagina i introduim valors en el TextBox veurem com ens
apareix el missatge “El valor estd fuera de los limites” quan enviem el formulari

amb un valor erroni.

Figura 76. Execucié de |'exemple d’un control de validacié

@@ @ http://localhost:4178/NuevoWebForm.aspx
@ localhost »

x 88| (Bl DebugBar @~ | @ @ ~| & ~| S| 100%
B v B v ) @ v Pagev Safetyv Toosv @~ $3 N [

9 El valor esta fuera de los limites

®100% ~

4.7.5. Controls de dades

Els controls de dades ens permeten mostrar grans quantitats de dades amb
suport de caracteristiques d’alt nivell com ordenacio, paginacio, etc. El control
per excel-léncia i més utilitzat d’aquest grup és el GridView.

Aquest control és extremadament flexible i ens mostra les dades en forma
de files i columnes. Amb aquest control es cobreixen les funcionalitats més
comunes en el maneig de dades, com son la paginaci6, I’ordenacio o la seleccio
d’elements.
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NPT S
Exemple practic d'as del GridView b Standard A
4 Data
Per a saber millor com funciona el GridView, en veurem un petit exemple practic. R Pointer
[} AccessDataSource
Igual que els altres controls, trobarem el GridView disponible en el Toolbox (figura 77). il Chart
Arrosseguem un GridView a l’editor i veiem com automaticament genera el codi xm1. 2 DataList
. ] 42 DataPager
Figura 78. Codi .aspx d’un control de dades . 9_
‘_,j DetailsView =
Client Objects & Events [ (NoEvents) L EntityDataSource
<%@ Page Language="C#" AutoEventWireup="true" CodeBehind="NuevoWebForm.aspx.cs" . i
Inherits="NuevaAppheb.NuevolebForm” %> 5 FormView
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" A GridView
"http://www.w3.org/TR/xhtml1/DTD/xhtmll-transitional.dtd"> ) .
=1<html xmlns="http://www.w3.0rg/1999/xhtml"> 51 LlanataSource
-I<head runat="server"> j ListView
<title></title>
</head> % ObjectDataSource
-1<body> = L=
= <form id="forml" runat="server"> = Repeater
=) Kdiv> T2
<asp:GridView ID="GridViewl" runat="server"> f’ QueryExtender
</asp:Gridview> [J  SiteMapDataSource
2 </divy] i P
</form> [ SqlDataSource
:5:::% [}, XmiDataSource
b Validation
> Navigation
ol amie S&
Figura 77. Controls de dades
100% ~ ¢«

A continuacié hem de proporcionar 1’origen de les dades al control. La manera més sen-
zilla és construir una llista d’objectes, de manera que creem una classe anomenada Per-
sona.

Figura 79. Exemple d’un GridView

—
Solution Explorer |4} View in Browser
=eia ] ) | Kl Convert to Web Application
3 Solution ‘Nuevaap| @&  Check Accessibility..

4 [ NuevaAppWet Calculate Code Metrics
> [=4 Properties

(<3l References KB Run Pex
3 Account Pex 4
E“ :Z'i’-zata Add » | & Newltem. Ctrl+Shift-A
> CF SMZS Add Reference... (2] Existing Item... Shift+Alt+A
b [Z] About.aspx Add Service Reference... 4 New Folder
=] Default.aspy Add Deployable Dependencies... Add ASP.NET Folder »
4] Global.asax Add Library Package Reference... New from Template »
[Z] NuevoWebf ) )
] Site.Master 7, View Class Diagram | Vg Class... Shift+Alt+C
3 Web.config Set as StartUp Project
Use IIS Express...
Debug >
(2% Add Solution to Source Control...
% Cut Ctrl+X
4 Paste Ctrl+V
X Remove Del
Rename
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Figura 80. Exemple d’un GridView

Installed Templates Search Installed Templates £
4 Visual C# -
Code Pex Class for VSTS Visual C# Type: Visual G
Dote An empty class declaration
General Web Form Visual C# |
Web
Windows Forms Web Form using Master Page Visual C#
WPF
Reporting 4| Web User Control Visual C#
Silverlight —
Workflow ch] class Visual C#
Online Templates
Master Page Visual G2
Nested Master Page Visual C#
@] HTMLPage Visual C#
Al style Sheet Visual C#
@ IScript File Visual C#
o] Interface Visual C#
f
ég ADO.NET Entity Data Model Visual C#
43, ADO.NET EntityObject Generator Visual C¥  ~
Name: Persona.cs
Add Cancel

Figura 81. Exemple d'un GridView

L Nu

4% NuevaAppW

Person:

oWebForm.asp; NuevoWebFor

am Explorer

Veb.Persona [ 2edad

Einamespace NuevaAppieb

= public class Persona

{
public string Nombre { get; set; }
public int Edag { get; set; }
}
¥
100% ~ <

A continuaci6, en l'esdeveniment Page Load de l'arxiu .cs generem una llista
d’objectes Persona.
Figura 82. Exemple d’un GridView

[ “% NuevaAppWeb.NuevoWebForm

¥ Page_Load(object sender, EventArgs €)

Fusing System;
using System.Collections.Generic;
sing m.Ling;

-Inamespace NuevaAppieb

{

5 public partial class NuevolebForm : Sy

.UI.Page

e protected void Page_Load(object sender, EventArgs e)

List<Persona> listaPersonas = new List<Persona>();
Persona primera = new Persona();

primera.Nombre = "Juan";

primera.Edad = 13;

Persona segunda = new Persona();

segunda.Nombre = "Juan”;|

segunda.Edad = 13;

listaPersonas.Add(primera);
listaPersonas.Add(segunda);

100% ~ ¢
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Finalment, relacionem la llista anterior creada amb 1'origen de dades o DataSource del
GridView.

Figura 83. Exemple d'un GridView

4 NuevaAppWeb.NuevoWebForm [ 3% Page_Load(object sender, EventArgs €)
-lusing System;
using System.Collections.Generic;

-Inamespace NuevaAppheb
public partial class NuevolWebForm : System.Web.UI
protected void Page_Load(object sender,

List<Persona> listaPersonas = new List<Pe
Persona primera = new Persona();
primera.Nombre = "Juan";

primera.tdad = 13;

Persona segunda = new Persona();
segunda.Nombre = "Juan";

segunda.Edad = 13;
listaPersonas.Add(primera);
listaPersonas.Add(segunda);

Gridviewl.DataSource = listaPersonas;
Gridviewl.DataBind();
}
}
}

100% ~ ¢

Si executem el nostre lloc web podem veure com automaticament es crea una Grid en que
les columnes son les propietats de la classe Persona i les files corresponen a cadascun
dels objectes de la llista.

Figura 84. Exemple d’un GridView

% - B b AT
\\3@@ http://localhost:4178/NuevoWebForm.aspx p-BeXx 8 ¢ ict
& localhost X

X 88~ | (B DebugBar @~ | | @ v| 2 v | Ziv| 100%
o~ v [ @ v Pagev Safety~ Toolsv @~ 33 & [

Nombre|Edad|
Juan 13
Juan 13

®100% ~

4.8. Controls d’usuari

Una aplicacié web ben construida divideix el codi en diferents blocs indepen-
dents. Com més modular és l'aplicaci6, més facil és mantenir-ne el codi, solu-
cionar errors i reutilitzar components. Per a I’organitzacio del codi en diferents
components ASP.NET posa a disposici6 del desenvolupador els UserControl o
controls d'usuari. Els UserControl s’assemblen molt als WebForm, ja que estan
compostos per una porcié de codi amb etiquetes HTML i controls de servidor

(l'arxiu .ascx) i un arxiu de codi amb la logica i els esdeveniments.

Les uniques diferéncies entre els UserControl i els WebForm sén:
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a) Els UserControl utilitzen ’extensié .ascx en lloc d’.aspx i la classe del
codi .cs hereta de UserControl en lloc de Page.

b) L'arxiu . ascx comenca amb la directiva <$@Control%> en lloc de <%@Pa-

ge%>.

c) Els UserControl no poden ser sol-licitats directament per un navegador.
Sempre han d’estar embeguts dins d'un WebForm.

4.8.1. Creacio d’un UserControl

La manera de crear un UserControl en el Visual Studio és molt similar a la
manera de crear un WebForm. Hem de seleccionar Add > Newitem i escollir Web
User Control de la llista. Li donem el nom, per exemple, de NouControl.ascx.

Figura 85. Creem un UserControl

Solution Explorer A= ¢
==l
(A NuevaAplicacion
=4 MyPr £ Build
> [ Accoy Rebuild
5 App L
23 Script
. o= Styl:s 5 Build Deployment Package
=] Abou! ¥ Publish...
[Z] Defau £ Package/Publish Settings

Clean

i s

] G1ob3 (& View in Browser Ctrl Shift+W
g \Sllv‘:bh: Convert to Web Application
Add * | ] Newltem... Ctrl+Shift+A
Add Reference... [ Existing Item... Shift+Alt+A
Add Service Reference... 4 New Folder
Add Deployable Dependencies... Add ASP.NET Folder »
Use IIS Express... #) Module...
Debug > | % Class..
Cut Ctrl+X
A  Paste Ctrl+V
Rename
[2 Properties Alt+Enter

] Solution Explorer [EENMEEE 03

Installed Templates [ search Installed Templates »|

4 Visual Basic Type: Visual Basic

Code Web Form Visual Basic

D An ASP.NET server control created using
ata the visual designer

General Z-S| Web Form using Master Page Visual Basic

Web

Silverlight 5= Web User Control Visual Basic

Online Templates Rl
Web User Control N .
Y8=]  Class (hesconn Visual Basic

Master Page Visual Basic

j Nested Master Page Visual Basic
‘ﬂ HTML Page Visual Basic
ﬁ Style Sheet Visual Basic
&f| IscrptFile Visual Basic
Voh  AJAX-enabled WCF Senvice Visual Basic
g ASP.NET Handler Visual Basic
g ASP.NET Module Visual Basic
T4 ASP.NET Server Control Visual Basic
Name: NuevojWebUserControl.ascx

Modifiquem l'arxiu .ascx perqué quedi de la manera segiient:
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Figura 86. Codi . aspx d’un UserControl

| Chent Objects & Events -|
O Control Language="CR" Autofventulrewps"tree™ CodeBehinds="NuevonebliserControl. ason, 8™
I Dnher Lts="Muevasnlicac Linkeb . MuevokeblserContral™ X
<aipslabel ID="lblPiePagina”™ runate™server™ [f»

(o Everts)

En l'arxiu de codi relacionat veiem com els esdeveniments son molt semblats

als dels WebForm. Modifiquem també aquest arxiu perqué quedi de la segiient
forma:

Figura 87. Codi . cs d'un UserControl

MuevoWebUserControlascrcs > JEEERRTAE IS

'f$ NuevahplicacitnWeb Nusvo'WebUserControl

'I ,'9 Page_Loa
=using System;

5
5
¢ 5

-namespace Huevadplicacidnieb

public partial class MuswoWeblUserlontrol

{

I, UserControl
protected void Page Load(object sender, Eventirgs e)

| lblPiefaging. Text = “Pic de pdgina.=;

Y -
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Per a poder provar aquest UserControl és necessari inserir-lo en un WebForm.
Es tracta d’un procés de dos passos. En primer lloc necessitem agregar la di-
rectiva Register a la pagina que contindra el UserControl just després de la

directiva Page.

<%@ Page Language = "C#" AutoEventWireup = "true" CodeBehind = "NouWebForm.aspx.cs"
Inherits = "NovaAplicacioWeb.NouWebForm" %>
<%@ Register TagPrefix = "customControls" TagName = "pie" Src = "NouWebUserControl.ascx" %>

En aquesta directiva, com podem veure, s’ha d’especificar un prefix i un nom.

La directiva Src serveix per a informar de la localitzaci6 del UserControl.

A continuaci6 hem d’inserir el UserControl en el WebForm com si fos un con-
trol de servidor, pero mitjancant la directiva segiient, especificant-ne el prefix

i el nom:

<diwv>
<customControls:peu runat = "server"></customControls:peu>

</div >

Si executem la pagina podrem veure com el UserControl es mostra com si fos

un control més (figura 88).

Figura 88. Execucié de I'exemple del UserControl

-

7 P
\\_»-)@J @ http://localhost6976/NuevoWebForm.aspx

& localhost x — -
X 88+ | (Bl DebugBar ®~ | | @& v| & ~| S| 100%
(e v [ @ v Pagev Safetyv Toolsv @~ g3 N M )

Body
Pie de pagina.

M

®100% ~

4.9. Pagines mestres

Quan dissenyem un lloc web, normalment disposem d’una série d’elements
comuns en totes les pagines: el logotip de I’organitzacié, un peu amb infor-

maci6, una serie d’enllagos generals, etc.
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Una novetat que va introduir ASP.NET son les pagines mestres. Gracies a aques-
tes es redueix el temps de disseny i el manteniment del lloc.

Una pagina mestra és una combinaci6 de codi HTML i controls de ser-
vidor, com qualsevol altra pagina d’ASP.NET, amb la peculiaritat que
s’emmagatzema en un arxiu amb extensi6é .master en lloc de I’extensio

habitual . aspx.

Una altra diferéncia respecte als WebForm se centra en la capcalera de l'arxiu

.master.

En una pagina mestra, la directiva Page és substituida per la directiva Master.

<%@ Master Language = "C#" AutoEventRireup = "true" CodeBehind = "Sitel.master.

Inherits = "NovaAppWeb.Sitel" %>

Com hem dit, en una pagina mestra podem introduir contingut HTML, com-
ponents de servidor i qualsevol altre contingut que hi pugui haver en una pa-
gina ASP.NET. El que distingira la pagina mestra d’altres és 1'aparicié com a
part del contingut d’'un o més, components ContentPlaceHolder.

Figura 89. Codi . aspx d'una pagina mestra

| Client Objects & Events | (No Events)
5@ Master Language="CB" AutoEventWireup="true” CodeBehind="Sitel.master.cs”
Inherits="Nuevaipphieb.Sitel™ %

<!IDOCTYPE html PUBLIC ™ /DTD XHTML 1.8 Transitional//EN"

f Forered . w3 . 0F g/ TR/ xR tml 1 /DTD whtmll-transitional . dtd™>

= <html xmlns="http:f v w3 . org/1998 xhiml™ >
chead runats"server™>
ctitler</titles
<aspilontentPlacetiolder ID="head” runate"server”:
</asp:ContentPlacetolder >

</head>
= <body»
«form ids"forml®™ runat="server™>
“divy
<asp:ContentPlaceHolder ID="ContentPlaceHolderl™ runat="sgrver™>

¢/asp:ContentPlaceHolders
</divy
«ffara>
< /body >
</ html»

100 %%

4.9.1. Components ContentPlaceHolder i Content

En dissenyar una pagina mestra anirem deixant uns buits o contenidors, re-
presentats per a components ContentPlaceHolder. Després, en cada pagina
individual s’introduira el contingut especific aportat pels components Con-
tent.

cs"
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El component ContentPlaceHolder, per tant, apareixera en l'arxiu .mas-
ter. La propietat que més ens interessa d’aquest component és 1'ID, a la qual
assignarem un identificador o nom, que sera el que serveixi per a enllacar-lo
amb el control Content.

Figura 90. Codi . aspx d’una pagina mestra

| Client Objects & Events =| (Mo Events)
%8 Master Language="C#" AuteEventWlreup="true” CodeBehind="Sitel.master.cs”
Inherits="Nuevaippheb. Sitel™ X

<IDOCTYPE html PUBLIC *-/fH3C//DTD XHTML 1.8 Transitional//EN"
“http: S Swwn Wl org/ TR/ xhtell /DTD xhitmli-trancsitional . ded™>

=<html wmlns="http: /v wl. org/1959 xhtml™>
= <head runat="server™>
ctitlerc/titler
<asp:ContentPlacetiolder ID="head” runat="server®:>
«/asp:ContentPlaceHalder »
«/head:
- <body >
= <form ide"forml™ runate™server™>
= adivy
<asp:ContentPlaceHolder ID="ContentPlaceHolderl™ runat="server™>

«faspiContentPlacetolders
ofdive
<« farm>
< /body>
</html>

Figura 91. Codi . aspx d’una pagina de contingut

| Client Objects & Events
<X%§ Page Language="CH" AutoEventWireup="true® CodeBehind="HuevobebForm.aspe.cs™
Inherits="Huevaipphieh. NusvoliebForm® MasterPageFile="r/Sitel. Haster“Xs

| (NoEvents)

|E<aspifontent ID="ContentHead"” ContentPlaceHolderIDs"head™ runats"serwver™r
<fasp:ontent>
= <asprContent IB="Contentl™ ContentPlaceHolderID="ContentPlacetolderl™ runat="server”>

<faspilontent>

% - 4 n

Veiem que per a referenciar la pagina mestra en el WebForm especific s’utilitza
la propietat MasterPageFile, que apareix com a atribut en la directiva page
d’aquelles pagines en que interessi incloure el disseny base.
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4.9.2. Exemple practic

Ara que coneixem a grans trets els elements principals de les pagines mestres,
podem veure com les podem utilitzar en el disseny d’un lloc senzill. Comen-
carem creant un nou projecto web buit. A continuacié obrim el quadre de
dialogo Add > New item amb el bot6 dret del ratoli sobre el nostre projecte i
seleccionem Master Page (figura 92).

Figura 92. Afegim una plantilla de MasterPage

Add New Item -
Installed Templates Sort by: [ Search Installed Templates 2|
4 Visual C# = )
3 £
Code Web Form Visual C# Type: Visual C -
Dote A Master Page for Web Applications
General Web Form using Master Page Visual G
Web -
Windows Forms [85]  web User Control Visual C#
WPF i
Reporting cho]  Class Visual C& |
Silverlight =
Workflow E Master Page Visual C#
Online Templates
| Nested Master Page Visual C#
@ HTML Page Visual C#
AS] Style Sheet Visual C#
@ IScript File Visual C#
ca.is AJAX-enabled WCF Service Visual C#
% ASP.NET Handler Visual C#
\g ASP.NET Module Visual C# '
A ASP.NET Server Control Visual C#  ~
Name: Sitel . Master
Add Cancel

Aquesta pagina mestra per defecte contindra inicament un contenidor Con-
tentPlaceHolder.

Figura 93. Codi . aspx d’una pagina mestra

| Client Objects & Events =] (Ho Event
<8 Master Language="C8" AutoEventWlreup="true” CodeBehind="Sitel.master.cs”
Inherits=“Nusvadplicac idnbeb, Sitel™ X2

<IDOCTYPE html PUBLIC -/ W3C//DTD XHTML 1.0 Transitional//EN"
“http: S S wd . org TR xhtal1 /070 chitmll-transiticnal . dtd™ >

= <html xwlns-'b};p:ffwww.w!;prgflgggthtgl'r
‘head runat="server™»

<titler</title>
< fhead>
= Ebody>
= <farm fd="forel® runat="server®s
= <divy

= <asp:fontentPlaceHolder IDs"ContentPlaceHolderl™ runats™server™:

<fasp:ContentPlaceHolder>
<fdiv>
< form>
diy @
</html>
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Introduim un contingut per defecte en el ContentPlaceHolder que es mos-
trara sempre que no el sobreescriguem amb el component Content que veu-
rem a continuacio, i agreguem els elements propis de la pagina mestra, com
la capcalera o el peu.

Figura 94. Codi . aspx d’una pagina mestra

| Client Objects & Events | Mo Events,
5@ Master Languages"C#" AutoEvemtWireups“true” Codefehind="Sitel master.cs®
Inheritsm“Nuevasplicacidnbeb, Sitel” X

<IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitienal//EN"
“http: ./ fewn w3 . org/ TR/ xhtml]l /DTD xhtmll-transitional.dtd™>
=i<html xmlnse"http: /v w3 org 1999 xhtml ™ »
chead runats"server™>
ctitlerc/ritles

</ head>
- chody>
- ofarm ide"forml™ runate”server™>
edivsCabecarad fdivs
= “divy
<asp:ContentPlaceHolder ID="ContentPlaceHolderl™ runats"server™»
Contenide por defecto
<fasprlontentPlaceHolders
<fdlvs
cdivePiec/dive
</ farm»
</ body >
<fhtml s
0% -

A continuacié obrim una altra vegada el ment Add > New item i seleccionem
Web Forms using Master Page. S’obrira una finestra que mostrara en la llista
dreta les pagines mestres disponibles. Triem la que acabem de crear.
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Figura 95. Afegim la plantilla de pagina de contingut

Installed Templates Sortby: i [ search Installed Templates 2|
4 Visual G2 a N
~ Type: Visual C#
Code Web Form Visual C# ype: Visua
Aform for Web Applications that is built
Data from a Master Page
General Web Form using Master Page Visual C#
Web - Web Form using Master Page |
Windows Forms @ Web User Control
WPF 1
Reporting 0‘9 Class Visual C# |
Silverlight =
[ Workflow ] Mesterpage Visual C#
Online Templates
D Nested Master Page Visual C#
@| HTMLPage Visual C#
A=l style Sheet Visual C#
&E|  script File Visual C#
oF 5y AJAX-ensbled WCF Service Visual C#
g ASP.NET Handler Visual C#
g ASP.NET Module Visual C#
Tﬂlf ASP.NET Server Control Visual C# <
Name: NuevolWebForm.aspx
Add Cancel
Select a Master Page (el x
Project folders: Contents of folder:
4 (2 NueveAplicacinWeb [l Sitel Master]

» (=4 Properties
1 [z References

Per a cada pagina que afegim al projecte i que enllacem a la pagina mestra,
haurem d’agregar un contingut en 1’'objecte Content corresponent. Per a re-
lacionar el component Content amb el seu ContentPlaceHolder correspo-
nent inicament hem d’indicar en el primer 1'1D del segon.

Figura 96. Codi . aspx d’una pagina de contingut

| Client Objects & Events -| (Mo Events)

£58 Page Title="" Language="C#" HasterPageFile="-~Ssitel.Hazter® AutcEventWlreup=“true®
Codefehind="NuevokebFors. aspu.c2™ Inherits="Nuevaiplicacidnieb. HuevoebFare™ X2

hlfp:fcntent ID="Contentl™ ContentPlaceHolderIDe"ContentPlaceHalderl” runate"server”§

< faspolontents
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Introduim el contingut que volem que aparegui en l'espai del ContentPla-

ceHolder.

Figura 97. Codi . aspx d’una pagina de contingut

| Client Objects & Events -] (No Events,
<X8 Page Title="" Language="Ci" HazterPageFilee"~/Sivel.Master® AutoEventWireup=“true®
Codefehinde"NusvekebFors. aspa. e1™ Inherits="Nuevadplicacidnieb . BuevoebFore™ X2
<aspilantent ID="Contentl® CoatentPlaceHolderID="ContentPlaceHalderl” runate"server”:
Contanide especifico de HusvobebFora|
<fasp:lontent>

Amb aquests passos simples ja tindrem una pagina accessible des del navega-
dor amb una capcalera, un contingut i un peu. Si executem l'aplicacio6, veurem
la pagina que hem creat inclosa dins de la pagina mestra (figura 98).

Figura 98. Execuci6 de I'exemple de MasterPage

"X 83+ | (B Debugbar @~ | | @& | £ v| cov] 1005 ~| ‘
R - B - & - Pagev Sofetyr Toos~ @~ 35 N 8 @ EE |

Cabecera
Contenido especifico de NuevoWebForm
Pie

®100%
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5. ASP.NET Ajax

En altres moduls hem vist com podem implementar la técnica Ajax mitjancant
JavaScript, i més concretament mitjancant I’objecte XMLHt tpRequest que hi
ha en tots els navegadors actuals. Aquesta manera de construir peticions asin-
crones, com hem vist, és bastant laboriosa i implica invertir molt temps de
treball.

ASP.NET posa a la disposici6é del desenvolupador ASP.NET Ajax per a facilitar la
tasca de la implementaci6 Ajax en els nostres llocs web. ASP.NET Ajax consta
de dues parts principals: una part del costat del client i una part del costat del

servidor.

La part del costat del client és un conjunt de biblioteques JavaScript. Basica-
ment, aquestes biblioteques afegeixen funcionalitats a JavaScript per a facilitar

el desenvolupament de les nostres aplicacions.

La part de servidor d’ASP.NET Ajax, que és la que de debo ens interessa, fun-
ciona en un nivell superior. Inclou controls i components que utilitzen les
biblioteques JavaScript del costat del client sense que n’hagim de tenir conei-

xement.
5.1. L'ScriptManager
L'ScriptManager és el cervell del model de servidor ASP.NET Ajax. Es tracta

d'un control web que no té cap aspecte visual; no obstant aixo, fa la tasca clau
del connectar els controls de servidor Ajax amb les biblioteques JavaScript.
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Per a agregar I'ScriptManager a una pagina, el podem trobar en el Toolbox en
I'apartat Ajax Extensions (figura 99). Una vegada arrossegat i deixat anar en
I'editor obtindrem el codi segiient (figura 100):

Figura 100. Codi .aspx d’un ScriptManager

| Client Objects & Events -] (Mo Events)
<% Page Language="C#" AutoEventilireup="true" CodeBehind="NuevolebForm.aspx.cs”
Inherits="Nuevadplicacidniieb.NuevokebForm™ ¥»

<IDOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN"
“http: /v w3 org/ TR xhtml1/DTD/xhtmll-transitional .dtd">

s ¢html xmlns="http://www.w3.org/1999/ xhtml"™>
-i<head runat="server”>
<titler<ftitlex
</head>
<body>
- <form id="forml™ runat="server">
<asp:ScriptManager ID="ScriptManagerl” runat="server"»
<fasp:ScriptManagers
<div>

<fdivy
£fform>
</body>
£/ html>

W% - 4 m

Cada pagina que utilitza controls ASPNET Ajax requereix una instancia i so-
lament una de ScriptManager.

5.2. Renderitzacions parcials amb UpdatePanel

Sens dubte, el control Ajax més important de tots és UpdatePanel. Aquest con-
trol ens permet fer renderitzacions parcials de la nostra pagina, és a dir, podem
recarregar parts de la nostra pagina sense haver de recarregar la pagina sencera.
L'escenari habitual d’'un UpdatePanel és el segilient:

e T’usuari llanca un esdeveniment com el clic d'un bot6 dins d'un Update-
Panel.

e ASP.NET Ajax intercepta I’esdeveniment i fa la petici6é asincrona de la pa-
gina al servidor.

e En el servidor es processa la pagina de manera normal i es retorna al na-
vegador.

e El navegador rep la pagina i el codi JavaScript s’encarrega de recarregar
solament I'UpdatePanel on es trobava el boto.

Toolbox

» Standard

> Data

» Validation

> Navigation

b Login

> WebParts

4 AJAX Extensions
R Pointer
3 ScriptManager
&3 ScriptManagerProxy
Timer
%1 UpdatePanel
& UpdateProgress

> Dynamic Data

> Reporting

> HTML

4 General

There are no usable controls in this group.
Drag an item onto this text to add it to the

toolbox.

Figura 99. Caixa d’eines
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L'UpdatePanel treballa en conjunt amb el control ScriptManager i, per tant,
quan utilitzem UpdatePanel hi ha d’haver abans un ScriptManager. Per tant,
per a fer un exemple primer, inserim un ScriptManager a la nostra pagina.
A continuacid, en el mateix apartat Ajax Extensions del Toolbox trobarem
I’'UpdatePanel. En inserir-lo a la nostra pagina, es generara el codi segiient (fi-
gura 101):

Figura 101. Codi . aspx d'un UpdatePanel

|  Client Objects & Events =] (Mo Events)
<% Page Language="C#" AutcEventWireup="true" CodeBehind="NuevokebForm.aspx.cs”
Inherits="Nuevatplicacidnkeb.NuevokebForm™ %>

<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN"
“http:/ fowe . w3, org/ TR xhtmll/DTD/ xhtmll-transitional . dtd”>

Sl <html »mlns="http://wew.w3.org/1999/ xhtml ">
-l<head runat="server®>
ctitler<ftitle>
</head>
| <body»
= <form id="forml™ rumat="server">
<asp:ScriptManager ID="ScriptManagerl” runat="server”»
</asp:SeriptManagers
<div>
<asp:UpdatePanel ID="UpdatePanell” runat="server">
</asp:UpdatePanel>
£fdive
</form>
</body>
</htmly

Wo% - 4 m

A continuaci6, inserim una Label dins de I'UpdatePanel per a anar mostrant

el resultat de la crida asincrona i un Button per a anar llancant aquesta crida.
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Figura 102. Codi . aspx d’un UpdatePanel

| Client Objects & Events -] (Mo Events)

< head>
5:<budy>
El <form id="forml® runat="server">»
<asp:ScriptManager ID="ScriptManagerl” runat="server">
<fasp:ScriptManager>
B <divz

= <ContentTemplate>
<asp:Label ID="Labell” runats"serwver” Texts"Label"s</asp:Label»
<asp:Button runat="server” Text="Buttom" />
| </ContentTemplate>
| & </asp:Updatepranz1j]
<fdiv»
| < fform>
| </body>
£/html>

100% = +

Fem el mateix procés per a agregar dos UpdatePanel més amb un Label i un

Button cadascun.

Figura 103. Codi . aspx d’un UpdatePanel

= €asp:UpdatePanel ID="UpdatePanell” runat="server" UpdateMode="Conditional®:

| Cient Objects & Events -] (NoEvents)
.<fhead>
=lgbody>
El «form id="forml® runat="server”:
<aspiscriptManager ID="ScriptManagerl” runat="server">
<!asp:5criptﬂanager>
=] <div>
E= casp:UpdatePanel ID="UpdatePanell” runat="server” UpdateModes"Conditional®»
=] <ContentTemplates>

<asp:Label ID="Labell™ runat="server" Text="Label"></asp:Label>
<asp:Button runat="server” Text="Button" />
</ContentTemplate>
</asp:UpdatePanel>

=] <ContentTemplate>
<asp:Label ID="Label2" runat="server" Text="Label":</asp:Label>
<asp:Button runat="server” Text="Button" />
<fContentTemplate>
</asp:UpdatePanel>

=] <ContentTemplate>
<asp:lLabel ID="Label3" runat="server" Text="Label"></asp:Label>
<asp:Button runat="server” Text="Button" />
</ContentTemplate>
</asp:UpdatePanel>
<fdiv>
| < /form>
| <fPody®
WH% = ¢

En 'arxiu . cs de la pagina escrivim el codi segiient per a actualitzar cadascun

de les Labels:

= <asp:UpdatePanel ID="UpdatePanel2” runat="serwver" UpdateModes"Conditional®»

=] <asp:UpdatePanel ID="UpdatePanel3” runat="server" UpdateMode="Conditional™>
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Figura 104. Codi . cs d’un UpdatePanel

MHueveWebForm.aspees X JI§ lebForm.aspx

4 MuevalplicacionWeb.NuevoWebForm ~| ¥ Page_Lc

lusing System;

-namespace NuevafplicacidnWeb

= public partial class NuevolWebForm @ System.Web.UI.Page
{

= protected void Page Load{object sender, Eventdrgs e)
Labell.Text = DateTime,MNow.ToString();

Label2.Text = DateTime.MNow.ToString();
Label3.Text = DateTime.MNow.ToString();

wWhae - 4

Si executem la pagina veurem com per a cada clic de qualsevol Button sola-
ment es refresca I'UpdatePanel on esta contingut, encara que hagim variat els
tres Labels.

Figura 105. Execucié de I'exemple d’UpdatePanel

, L PRI 08 . - o] ]
(\3@ @ http://localhost6976/NuevoWebForm.aspx el 5'¢ fod

& localhost x
x 88| Eocbugtar S| @] @ ~| £ ~[ 257|105 -] @7 ) v B Buscoren Googe || Destacar enia pigna -
f v B v @ v Pagev Safety~ Toos~ @~ 35 N N ) i}
07/11/2011 15:17:33

07/11/2011 15:17:27
07/11/2011 15:17:31

®100% ~

5.3. Indicacié d’estat amb UpdateProgress

Mentre un navegador renova una pagina mostra a l'usuari algun tipus
d’indicacid, com per exemple una icona animada o un canvi progressiu de
color en la barra d’adreces, que permet saber que es troba ocupat, esperant
rebre resposta del servidor. Per defecte, les aplicacions Ajax no tenen aquest
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tipus de comunicaci6é de retorn, que resulta important, ja que sense aquesta
la persona que utilitza el navegador no sap si la comunicaci6 esta en curs o és
que l'aplicaci6 senzillament ha deixat de funcionar.

Introduir una indicacié d’estat en una aplicacié ASP.NET Ajax resulta molt
senzill, ja que hi ha un component anomenat UpdateProgress que s’encarrega
de col-locar en la pagina I’element de notificaci6 que vulguem. Aquesta noti-
ficacio, a més, es pot mantenir oculta fins al moment en que el temps d’espera
superi un cert limit, i torna a desapareixer automaticament quan la resposta
ha arribat. Les dues propietats clau d’aquest component sé6n AssociatedUp-
datePanellID i DisplayAfter. Amb la primera, I’'UpdateProgress s’associa
amb un UpdatePanel de la pagina, mentre que la segona estableix el nombre
de mil-lisegons d’espera després dels quals es fara visible la indicacio.

Igual que altres components, UpdateProgress és un contenidor inicialment
buit. Perque faci el seu treball, és necessari introduir-hi algun contingut: una
etiqueta de text, un petit grafic, etc.

Partint de 'exemple del subapartat anterior afegirem a l'interior del primer
UpdatePanel un UpdateProgress i, dins d’aquest, una simple etiqueta de text

amb un missatge.

Figura 106. Codi . aspx d’un UpdateProgress

| Cliem Objects & Events =] (NoEvents,
<8 Page La

Inl

=" C#" AutoEventWireup="trie* CodeBehind="NusvobebFors.aspx.cs”
="Nuevasplicacidnbeb, NuevekiebFora® B

<IDOCTYPE heml PUBLIC =-//W3CS/DTD XHTML 1.8 Transitioenals/EN"
“hEtg: S e, w3 . org TR chtmll /DTDS xhtsll -trsnsitional ., dtd™ >
—<html smlns="hEtp:/ /v .wd . org 1000/ xhtml "
- <head runat
stitlex</titles
& head >
<bodys
ifgrm id="forml" runat="server":
casp:Scriptianager ID="ScriptManagerl” renat="server™>
<faspiSoriptManagers
div»
<aspilpdatePanel ID="UpdatePanell® runat="server™s
<ContentTesplate:
<aspilabel ID="Labell™ runats”server” J»
Button ID="Buttonl” runate”server” Texta"Button™ onclicks®Buttonl Click™/»

"server”y

<azp:UpdateProgress IDs"UpdateProgressl™ runats™server™>
<ProgressTemplate>
<asp:label ID="Labell” runat="server” Text="Cargandg..."/»
</ProgressTemplater

<fasp:lUpdateProgresss
</ContentTesplate:
<fmspiUpdatePansl>
ofdivy
¢ ffarms
</fbody>
£ html
1% =+

Si executem el projecte, no descobrirem en principi cap diferéncia, ja que
I'UpdateProgress esta programat per a mostrar el missatge si la resposta triga
més de mig segon a arribar. En un entorn real es podria donar el cas que la
petici6 trigués més de mig segon, pero provant en local, la resposta és gairebé

immediata.
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Per a simular aquest temps d’espera escriurem el codi segiient, que retarda el
fil d’execucio:

Figura 107. Codi . cs d'un UpdateProgress

MusvaWebFormuaspecs 0 ISR TE

 NuevatplicaciénWeb. NuewoWebForm T
using System;

- namespace MuesvasplicacidnWeb

public partial class NuewchiebFors @ Page

{

protected void Page Load(object sender, Eventirgs e)

{
¥

protected void Buttenl Click(object sender, Eventirgs e)
T
L

Labell.Text = DateTime.Mow. Tostring();

System. Threading. Thread.Sleep{150@) ;

%
I

% - 4

Ara, en executar de nou l'aplicacio, es podra apreciar perfectament el funcio-
nament del component UpdateProgress.

5.4. ASP.NET Ajax Control Toolkit

Els controls UpdatePanel i UpdateProgress son bastant ttils. No obstant aixo,
sOn els tinics controls Ajax que es troben en ASP.NET. Per a ampliar la gamma
de controls Ajax Microsoft i la comunitat ASP.NET van desenvolupar ASP.NET
Ajax Control Toolkit.

ASP.NET Ajax Control Toolkit esta format per desenes de controls que utilitzen
les biblioteques JavaScript d’ASP.NET Ajax per a crear efectes sofisticats. Dos
factors que ASP.NET Ajax Control Toolkit té al seu favor son:

o Ts completament gratuit.

e Se n’inclou el codi font complet, i gracies a aix0 el programador podra
personalitzar els controls que el componen.

5.4.1. Instal-lacié d’ASP.NET Ajax Control Toolkit

Per a baixar I’ASP.NET Ajax Control Toolkit, anirem a l’adreca Ajax Control
Toolkit.


http://ajaxcontroltoolkit.codeplex.com/
http://ajaxcontroltoolkit.codeplex.com/
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Una vegada hagim baixat 'arxiu .zip simplement descomprimim !’arxiu
AjaxControlToolkit.dll. Per a aconseguir integrar ASP.NET Ajax Control
Toolkit amb el nostre lloc web, hem de seguir una serie de passos:

1) Primer de tot és necessari crear un apartat nou en el nostre Toolbox pre-
ment amb el bot6 dret sobre aquest i seleccionant Add Tab (figura 108). El nou
apartat I'anomenem “Control Toolkit”.

Figura 108. Afegim una seccié per a Control Toolkit

Toolbox A X
i> Standard
> Data
> Validation
> Navigation
> Login
> WebParts
> AJAX Extensions
> Dynamic Data
> Reporting
> HTML
4 General

Therear| [ Paste Ctrl+V jto this text to add it to the toolbox.
v | List View
Show All
Choose Items...
Sort Items Alphabetically

Reset Toolbox

Add Tab
Delete Tab
Rename Tab
Move Up
Move Down
Toolbox A X

i> Standard

b Data

b Validation

> Navigation

> Login

> WebParts

> AJAX Extensions

> Dynamic Data

> Reporting

» HTML

4 Control Toolkit
There are no usable controls in this group. Drag an item onto this text to add it to the toolbox.
4 General

There are no usable controls in this group. Drag an item onto this text to add it to the toolbox.
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En aquest moment tenim un nou apartat en el Toolbox, pero no conté cap
control. Per a afegir els controls premem amb el bot6 dret sobre Control Toolkit
i seleccionem Choose items (figura 109). A continuacio, explorem en el nostre
sistema i escollim l'arxiu AjaxControlToolkit.dl1l que vam extreure ante-

riorment.

Figura 109. Afegim una seccié per a Control Toolkit

Toolbox
i Standard
> Data
> Validation
> Navigation
b Login
> WebParts
> AJAX Extensions
> Dynamic Data
> Reporting
> HTML
4 Control Toolkit

There are
L

4 General v

There are

Automaticament, es crearan tots els controls en el nostre nou apartat Control

Toolkit (figura 110).

Paste

List View

Show All

Choose Items...

Sort Items Alphabetically
Reset Toolbox

Add Tab

Delete Tab

Rename Tab

Move Up

Move Down

Ctrl+V

to this text to add it to the toolbox.

o this text to add it to the toolbox.
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Figura 110. Afegim una seccié per a Control Toolkit

Toolbox vyAXx
4 Control Toolkit

Pointer

% HoverMenuExtender

3]  ValidatorCalloutExtender
PagingBulletedListExtender
NoBot

Twitter

P 4

PopupControlExtender

m

AnimationExtender
Gravatar
CalendarExtender
AsyncFileUpload —
MutuallyExclusiveCheckBoxExtender

HtmlEditorExtender

DragPanelExtender

Accordion

SliderExtender

ModalPopupExtender

ToolkitScriptManager

RoundedCornersExtender
ListSearchExtender

ComboBox

EMQLu@uﬁwuﬁﬁﬂﬁﬁmﬁ%m£

P, T N

2) El segon pas important és afegir la biblioteca AjaxControlToolkit.dll
al nostre lloc web. Premem amb el bot6 dret sobre la carpeta References i selec-
cionem Add Reference. A continuacio, explorem en el nostre sistema i escollim
l'arxiu AjaxControlToolkit.dll (figura 111).

Figura 111. Afegim una referéncia a Control Toolkit

GSEe
-a Solution ‘NuevaAplicacionWeb' (1 project)
4 A NuevaAplicacionWeb

> [=d| Properties

> =2 References

=] NuevoWe Add Reference...
i EuevoWe Add Service Reference...
é z::: Add Library Package Reference...
> |3 Web.conf Add Moles Assembly for mscorlib

@ sHEle
; Solution 'NuevaAplicacionWeb' (1 project)
4 A NuevaAplicacionWeb

> [=d| Properties

4 3] References
3 AjaxControlToolkit
«3 Microsoft.CSharp
<3 System
+3 System.Configuration
+3 System.Core
3 System.Data
+3 System.Data.DataSetExtensions
+3 System.Drawing
+3 System.EnterpriseServices
3 System.Web
3 System.Web.ApplicationServices
3 System.Web.DynamicData
3 System.Web.Entity
+3 System.Web.Extensions
3 System.Web.Services
3 System.Xml
3 System.Xml.Ling

=] NuevoWebForm.aspx

a8 NuevoaWehllcerCantral accy

Solution Explorer ¥ 8 X | §Solution Explorer voXx

m

Una vegada afegida la biblioteca dels controls I’'hem de registrar en cada Web-

Form o UserControl que vulguem amb la directiva Register.

<%@ Register Assembly = "AjaxControlToolkit" Namespace

"AjaxControlToolkit" TagPrefix = "asp"

A partir d’ara podrem utilitzar qualsevol control d’ASP.NET Ajax Control To-

olkit mitjancant I'etiqueta <asp: NomControl></asp: NomControl>.

oo
Vv
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La biblioteca ASP.NET Ajax Control Toolkit, com ja hem dit, disposa de mul-
titud de controls. L'objectiu del modul, com ja hem anat comprovant, no és
una analisi exhaustiva de tots els controls, siné veure uns exemples basics al
més generics possibles. En els dos subapartats segiients veurem dos controls
d’exemple per a veure com s’utilitzen: Accordion i AutoCompleteExtender.

5.4.2. Accordion

Un control Accordion és un contenidor en forma de pila amb diversos panells
en queé se’n pot veure només un cada vegada. Cada panell té una capgalera i
un contingut. Quan es fa clic en la capcalera d'un, el panell s’expandeix i es

mostra el contingut alhora que els altres panells es minimitzen.

Per a fer un petit exemple amb el control Accordion crearem un nou WebForm,
al qual afegirem la directiva:

<%@ Register Assembly = "AjaxControlToolkit" Namespace = "AjaxControlToolkit"

TagPrefix = "asp" %>

Com qualsevol altre control Ajax, els controls de la biblioteca ASP.NET Ajax

Control Toolkit necessiten la preséncia d'un control ScriptManager.

A continuacié arrossegarem el control Accordion de 1 Toolbox, amb la qual
cosa es creara el codi segiient (figura 112):

Figura 112. Codi . aspx d’un Accordion

MuevoWebForm.aspx® = EEEE 5 4 L ebloerCe 3 MuswaW

| Client Objects & Events | (Mo Events)

<IDOCTYPE html PUBLIC ==/ /W3C//DTD XHTHL 1.8 Transitional//EN™
“http: /o w3, org TR/ xhtell /07D shtmll-transitional . dtd™>

<html xmlns="http:/ wew.w3.org/1999 xhtml" »
<hegad runats"server”:»
ctitlese/titles
< head>
<hody>
{form id="forml"™ runat="server”>

fasp:ScriptManager ID="ScriptManagerl” runat="seérver":
<fasprScriptManagers
<diva
= <asp:Accordion Ib="Accordionl™ runat="server™»

<faspraccordions
<fdiv>
</ forms
«fbady >
< fhtml >

W% - <
3 Design | O Split _=l Source ii:c'h-tmlajjcbody:]lcforrr#foml:-l[tdiv:-l <asprdccordion®Accordion] »

Seguidament afegirem el codi segilient per a construir el nostre Accordion (fi-
gura 113):
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Figura 113. Codi . aspx d’un Accordion

| Client Objects & Events -
- chody>
- Bform ide"forml® runats”server™>
<asp:ScriptManager ID="ScriptManagerl™ runats"server™>»
<fasp:ScriptManager>

= cdivy
<asprAccordion ID="Accordionl”™ runat="server”:
LPanes>
- <aspiAccordlonPane ID="AccordionPanel” runat="server”:
- tHeader»
Header 1
< /Header»
= <Cantents
Pane 1
dfContents
< fasprAccordionPane»
- <aspraccordlonPane ID="AccordlonPanel” runate="server®:
- tHeaders
Header 2
< /Header»
= <Cantents
Pane 2
<fContent?
<fasprAccordionPane
</Paness
<faspiaccordion:
<fdivey
|’ <ffurll
100% = ¢

Veiem com cada secci6 del nostre Accordion es correspondra amb un Accor-
dionPane i cada AccordionPane conté un Header (que sera el que es mos-
tri com a capgalera) i un Content (que sera el que es mostri quan el panell
s’expandeixi).

Si executem la nostra web podrem comprovar el funcionament de I’Accordion
(figura 114).

Figura 114. Execucié de I'exemple de I’Accordion

;ﬁvvaévpagevafﬁyVTwnlsvevu@@ 1 i

|| Header 1
Pane 1
Header 2

®100% v
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5.4.3. AutoCompleteExtender

L'exemple anterior de 1’Accordion mostra un control totalment nou que té
caracteristiques Ajax. En la biblioteca ASP.NET Ajax, Control Toolkit no és el
cas més comd, ja que el més normal sén controls que es complementen amb
els ja existents en ASP.NET per a afegir-los funcionalitats Ajax.

Una d’aquestes extensions de control és AutoCompleteExtender, que es com-
plementa amb controls com TextBox, i ens va oferint una llista de valors possi-
bles mentre ["'usuari introdueix caracters. Si l'usuari fa clic en un dels elements

de la llista, el valor es copia dins del quadre de text.

Per a veure la funcionalitat de I’AutoCompleteExtender crearem un petit

exemple. Primer de tot inserirem un TextBox en un nou WebForm.

Figura 115. Codi . aspx d’un AutoCompleteExtender

NuevoWebForm.aspx X [REEIIEEVE Sitel Master -

Client Objects & Events .I (No Events) -
<%@ Page Language="C#" AutoEventWireup="true" CodeBehind="NuevoWebForm.aspx.cs" Inherits="NuevaAppheb.NuevolebForm" %> +(m

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtmll-transitional.dtd">

=I<html xmlns="http://www.w3.0rg/1999/xhtml">
mi<head runat="server">
<title></title>
</head>
=l<body>
] <form id="forml" runat="server">
2 <div>
<asp:TextBox ID="TextBoxl" runat="server"></asp:TextBox>
</div>
</form>
</body>
</html>

n

100% ~ ¢ ’
@ Design | O Split | @ Source

A continuacio, i com en tots els controls Ajax, inserirem un ScriptManager que
controlara la part JavaScript del control. En aquest moment ja estem en con-
dicions d’agregar el control AutoCompleteExtender a continuaci6é del nostre
TextBox. Unicament hem de configurar tres propietats del control:

® TargetControlID: identificador del control sobre el qual s’aplicara
I'extensio.

e MinimumPrefixLength: a partir que 'usuari escrigui x caracters, es mos-

trara la llista.

® ServiceMethod: metode que s’encarregara de retornar els items que es
mostraran en la llista
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Figura 116. Codi . aspx d'un AutoCompleteExtender

HueveWebFormasps 2 |8

CHent Objects & Events | o Events)
X8 Page Language="C#" AutofventWireup="true” Codefehind="NuevckebForm.aspx.cs™
Inheritss="Nucvafppiel. NucvokebForm™ X»

<X8 Register Assesbly="AjaxContrelToclkit™ Nomespace="AjaxControlToolkit™ TagPrefix="asp" ¥

<!DOCTYPE html PUBLIC “-//W3C//DTD XHTML 1.8 Transitional//EN®
“hitp: e w3 org TR xhtml 1 FDTDS whimll-transiticnal  dtd™»

S<html wmlns="http: /v w3 org 1599 xtml ">
=l <head runat="serverss
ctitlercfeitles
</head>
Hl<bady >
= cform ide“forml® runat="server®:
<asp:SeriptManager I0="ScriptManagerl” runats®ierver™>
</asp:ScriptManager:
= <div>
<asp:TextBox ID="TextBoxl" rumat=~server™><{/asp:TextBoox:
{aspréutoCompleteExtender I0="AutoCompleteExtenderl™ TargetControlIbs"TextBoxi"”
MinimumPrefixlengtha™2" ServiceMethods™Getlista™ runats"server™»
</asp:éutofompleteExtenders
« divs
< Forms
<bady>
< fhtnl>

W% - m
L4 Design | 2 Spiit ._l Source |i[tlnml:-”cbodys-ll-clnm#nnﬂl:-”edh» <aspeAutolomplateExtender.. >

El meétode que retornara la llista de strings que es mostrara ha de tenir les ano-
tacions de WebMethod i ScriptMethod perqué sigui accessible directament
des de JavaScript.

Figura 117. Codi . cs d’un AutoCompleteExtender

NusvoWebForm.aspics X

I Musvapp Wb MuevoWebForm =| N Ge

Snasespace Huevaspplieb

- public partial class NuevolebForm @ Systes,web, UL, Page
{

public static List<string> listaTotal = Aew Listcstrings();
= protected void Page Load(cbject sender, Eventirgs &)

listaTotal.Addrangs(new ~teing[]{"abe™,"abed™, "abede”, "aber™, “abedt™});
H

[System.Web.Services.WebMethod]
[System.wWeb.5cript.Services. Scriptiethod]
= public static List<string» GetLista(string prefixText, int count)

{
.i:f{string:n listaResultante = new ::int-::tring:{};
forepch (string item in listaTotal)
if (item.StartsWith{prefixText))
listaResultante, Add{iten);
}
}
return listaResultante;
}
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Veiem com tenim una llista amb tots els string “llistaTotal” i inicament hem de
comprovar en la funcié GetLlista si cada element d’aquesta llista comenca
per la cadena entrada per 1'usuari.

Si executem 1’aplicacié web veurem com a mesura que l'usuari insereix carac-

ters la llista es va actualitzant.

Figura 118. Execucié de I'exemple de I’AutoCompleteExtender

A=Y

@ nttp://localhost:4178/NuevoWebForm.aspx

& localhost X
*x 88~ | [ oebuger &+ | ] (@ - | £ v| fav|100% -]
- v [ @ v Pagev Safety~ Toolsv @~ 33 N &

®100% ~
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